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Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means,
electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson
Corporation. The information contained herein is designed only for use with this Epson printer. Epson is not responsible for
any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of this
product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly
comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any
consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson

Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs
from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson Corporation.

EPSON® is a registered trademark and Exceed Your Vision is a trademark of Seiko Epson Corporation.
Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.
Apple®, Macintosh® and Mac OS® are registered trademarks of Apple Inc.

DPOF™ is a trademark of CANON INC., Eastman Kodak Company, Fuji Photo Film Co., Ltd. and Matsushita Electric
Industrial Co., Ltd.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their
respective owners. Epson disclaims any and all rights in those marks.

Copyright © 2009 Seiko Epson Corporation. All rights reserved.
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Operating System Versions

In this manual, the following abbreviations are used.

Windows refers to Windows 7, Vista, XP, 2000, Server 2008 and Server 2003.

a

a

Windows 7 refers to Windows 7 Home Premium Edition, Windows 7 Professional Edition, Windows 7 Ultimate
Edition.

Windows Vista refers to Windows Vista Home Basic Edition, Windows Vista Home Premium Edition, Windows
Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista Ultimate Edition.

Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and Windows XP
Professional Edition.

Windows 2000 refers to Windows 2000 Professional.

Windows Server 2008 refers to Windows Server 2008 Standard Edition and Windows Server 2008 Enterprise
Edition.

Windows Server 2003 refers to Windows Server 2003 Standard Edition and Windows Server 2003 Enterprise
Edition.

Macintosh refers to Mac OS X.

g

Mac OS X refers to Mac OS X 10.3.9 or later.

Operating System Versions 10
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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using the printer. Also, be sure to follow all
warnings and instructions marked on the printer.

Setting up the printer
Observe the following when setting up the printer:

(d Do not block or cover the vents and openings in the printer.
[ Use only the type of power source indicated on the printer’s label.

[ Use only the power cord that comes with the printer. Use of another cord may result in fire or
electric shock.

(d The printer’s power cord is for use with the printer only. Use with other equipment may result
in fire or electric shock.

[ Be sure your AC power cord meets the relevant local safety standard.

(d Avoid using outlets on the same circuit as photocopiers or air control systems that regularly
switch on and off.

[ Avoid electrical outlets controlled by wall switches or automatic timers.

[ Keep the entire computer system away from potential sources of electromagnetic interference,
such as loudspeakers or the base units of cordless telephones.

d Do not use a damaged or frayed power cord.

(d If you use an extension cord with the printer, make sure that the total ampere rating of the
devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make
sure that the total ampere rating of all devices plugged into the wall outlet does not exceed the
wall outlet’s ampere rating.

(d Do not attempt to service the printer yourself.

Safety Instructions 11
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Unplug the printer and refer servicing to qualified service personnel under the following
conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been
dropped or the casing damaged; the printer does not operate normally or exhibits a distinct
change in performance.

If you plan to use the printer in Germany, the building installation must be protected by a 10
or 16 amp circuit breaker to provide adequate short-circuit protection and over-current
protection for the printer.

When connecting the printer to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a
connector in the wrong orientation may damage both devices connected by the cable.

If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are
fuses in the plug, make sure you replace them with fuses of the correct size and rating.

Do not hold the duplex unit when you lift the printer to prevent the duplex unit from
becoming detached. Also, make sure that the duplex unit is attached correctly after setting up
the printer.

Choosing a place for the printer

Observe the following when choosing a place for the printer:

a

Place the printer on a flat, stable surface that extends beyond the base of the printer in all
directions. If you place the printer by the wall, leave more than 10 cm between the back of the
printer and the wall. The printer will not operate properly if it is tilted at an angle.

When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside
down. Otherwise, ink may leak from the ink packs.

Leave enough space in front of the printer for the paper to be fully ejected.

Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer
away from direct sunlight, strong light, or heat sources.

Avoid places subject to dust, shocks, or vibrations.
Leave enough room around the printer to allow for sufficient ventilation.

Place the printer near a wall outlet where the plug can be easily unplugged.

Safety Instructions
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Using the printer
Observe the following when using the printer:

Avoid touching the components inside the printer unless instructed to do so in this guide.
Do not insert objects through the slots in the printer.

Take care not to spill liquid on the printer.

Do not touch the white flat cable inside the printer.

Do not put your hand inside the printer during printing.

U0 J d od o

Do not use aerosol products that contain flammable gases inside or around this product.
Doing so may cause fire.

U

Do not move the print head by hand; otherwise, you may damage the printer.
Do not move the cartridge lever during printing.

[  Always turn off the printer using the ) Power button. When this button is pressed, the
O Power light flashes. Do not unplug the printer or turn off the power to the outlet until the
O Power light stops flashing.

[ Before transporting the printer, make sure that the print head is in the home (far right) position.

(d Be careful not to trap your fingers when closing the printer cover.

Handling ink cartridges

Observe the following when handling ink cartridges:

(d Keep ink cartridges out of the reach of children and do not drink the ink.

(d If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

Safety Instructions 13
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[ For best results, shake the ink cartridge for about five seconds.

0:00'05"
()

5

n Caution:
Do not shake cartridges (that have been installed previously) with too much force.

Do not use an ink cartridge beyond the date printed on the cartridge carton.
Use up the ink cartridge within six months of installation for best results.
Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.

Store ink cartridges in a cool, dark place.

I R T R I

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room
temperature for at least three hours before using it.

L

Do not touch the green IC chip on the side of the cartridge. This may affect normal operation
and printing.The IC chip on this ink cartridge retains a variety of cartridge
related-information, such as the ink cartridge status, so that the cartridge may be removed and
reinserted freely. However, each time the cartridge is inserted, some ink is consumed because
the printer automatically performs a reliability check. If you remove an ink cartridge for later
use, protect the ink supply area from dirt and dust, and store it in the same environment as this
product. Note that there is a valve in the ink supply port, making covers or plugs unnecessary,
but care is needed to prevent the ink from staining items that the cartridge touches. Do not
touch the ink supply port or surrounding area.

Warnings, Cautions, and Notes

Warnings, Cautions, and Notes in this User’s Guide are indicated as below and have the following
meaning.

Warnings

must be followed carefully to avoid bodily injury.

Safety Instructions 14
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g Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of the printer.

Safety Instructions 15
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Chapter 1
Using Your Software

Overview of Printer Driver and Status Monitor

The printer driver lets you choose from a wide variety of settings to get the best printing results.
The status monitor and the printer utilities help you check the printer and keep it in top operating
condition.

Accessing the printer driver for Windows

You can access the printer driver from most Windows applications, the Windows Start menu, or
the taskbar.

To make settings that apply only to the application you are using, access the printer driver from
that application.

To make settings that apply to all of your Windows applications, access the printer driver from the
Start menu or the taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User’s Guide are from Windows XP.

From Windows applications

1. Click Print or Print Setup on the File menu.

2. In the window that appears, click Printer, Setup, Options, Preferences, or Properties.
(Depending on your application, you may need to click one or a combination of these buttons.)

From the Start menu

d Windows 7:
Click @ Start, click Devices and Printers. Right-click the icon for your printer and select
Printing preferences.

Using Your Software 16
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(d Windows Vista and Server 2008:
Click @ Start, click Control Panel, then double-click Printers. Right-click the icon for your
printer, then click Select Printing Preferences.

d Windows XP and Server 2003:
Click Start, click Printers and Faxes. Right-click the icon for your printer, then click
Printing Preferences.

(1 Windows 2000:

Click Start, point to Settings, then click Printers. Right-click the icon for your printer, then
click Printing Preferences.

From the shortcut icon on the taskbar

Right-click the printer icon on the taskbar, then select Printer Settings.

To add a shortcut icon to the Windows taskbar, first access the printer driver from the Start menu
as described above. Next, click the Maintenance tab, the Speed & Progress button, and then the
Monitoring Preferences button. In the Monitoring Preferences window, select the Select
Shortcut Icon check box.

Getting information through online help

You can access online help for items in the printer driver from your application or the Windows
Start menu.

= See “Accessing the printer driver for Windows” on page 16.

In the printer driver window, try one of the following procedures.

(d Right-click the item, then click Help.

[ Click the ﬂ button at the top right of the window, then click the item (for Windows XP and
2000 only).

Accessing the printer driver for Mac OS X

The table below describes how to access the printer driver dialog.

Using Your Software 17



B-310N/B-510DN  User’s Guide

Dialog How to Access It

Page Setup Click Page Setup on the File menu of your application.

Note for Mac OS X 10.5:
Depending on your application, the Page Setup menu may not appear in the File menu.

Print Click Print on the File menu of your application.
EPSON Printer You can access this software in the following three ways:
Utility3

d Double-click the EPSON Printer Utility3 icon in the Applications folder in
Macintosh HD. Select the printer from the Printer List, then click OK.

d Click Print from your application’s File menu, choose Print Settings in the Print
window that is displayed, then click the |77 Utility icon. This Utility icon is not
displayed when the printer is shared.

d  ForMacOS X 10.3 and 10.4 only
Open the Applications folder on your hard drive, then open the Utilities folder
and double-click the Print Center or Printer Setup Utility icon. Select the
appropriate printer from the list, then click the Configure or Utility button.

Getting information through online help

Click the r?\" Help button in the Print dialog.

Using Your Software 18
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Printing Web Pages to Fit to Your Paper Size

EPSON Web-To-Page
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EPSON Web-To-Page lets you make Web pages fit to your paper size when printing. You can also
see a preview before printing.

Note for Windows:
This software is not available for Windows 7, Vista, XP x64, Server 2008, and Server 2003.

Note for Windows Internet Explorer 7 or later:
Printing web pages to fit to your paper size is a standard feature in Windows Internet Explorer 7 or
later.

Note for Mac OS X:
A This software is not available for Mac OS X.

[ Printing web pages to fit to your paper size is available by using the printer driver.

= See “Printer settings for Mac OS X 10.5” on page 39.
® See “Printer settings for Mac OS X 10.3 or 10.4” on page 41.

Using Your Software 19
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Accessing EPSON Web-To-Page

After you install EPSON Web-To-Page, the menu bar is displayed on the Windows Internet
Explorer Toolbar. If it does not appear, select Toolbars from the View menu of Internet Explorer,
and then select EPSON Web-To-Page.

3 Epson Global Home - Microsoft Internet Explorer

File Edit ‘Wiew Fawaorites Tools  Help

- 1 *\ ™y _|nl_ .
@Eack ?, ﬂ ﬂ | g Search NFavurltes

Address @:ﬁ httpe ffwnany, epson. com/
EPSON Web-To-Page = (=hPrint | S Print Preview

Uninstalling the Printer Software

Uninstalling the printer driver

You may need to uninstall your printer driver if you:

(1 Upgrade your computer’s operating system.
(d Update your printer driver with a newer version.
(d Have a problem with the printer driver.

If you are upgrading your operating system or updating the printer driver version, be sure to
uninstall the current printer driver before upgrading or installing the new driver. Otherwise, the
driver update will not work.

For Windows

Note:
1 To uninstall programs in Windows 7, Vista and Server 2008, you need an administrator account
and the password if you log on as a standard user.

d  To uninstall programs in Windows XP and Server 2003, you must log on to a Computer
Administrator account.

Using Your Software 20
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1 To uninstall programs in Windows 2000, you must log on as a user with administrative
privileges (belonging to the Administrators group).

1. Turn off the printer and disconnect its interface cable.

2. Windows 7, Vista and Server 2008:
Click the start button and select Control Panel.

Windows XP and Server 2003:
Click Start and select Control Panel.

Windows 2000:
Click Start, point to Settings, and select Control Panel.

3. Windows 7, Vista and Server 2008:
Click Uninstall a program from the Programs category, and then select your printer from

the list.

Windows XP, 2000 and Server 2003:
Double-click the Add/Remove Programs icon and select your printer from the list.

4. Windows 7, Vista and Server 2008:
Click Uninstall/Change.

Windows XP, 2000 and Server 2003:
Click Change/Remove.

5. Select the icon for your printer and click OK.

6. Click OK to uninstall the printer driver.

For Mac OS X
Note:
To uninstall the programs, you must log on to a Computer Administrator account. You cannot
uninstall programs if you log on as a Limited account user.

1. Quit all running applications.

2. Insert the Epson printer software CD-ROM into your Macintosh.

Using Your Software 21
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6.

7.

Double-click the Mac OS X icon in the Epson folder. The CD Installer screen is displayed.
Click Custom Install.

Select Printer Driver.

Note:
If the Authenticate dialog appears, enter your password or phrase and click OK.

Read the software license agreement and click Accept.
Select Uninstall from the menu in the upper left and click Uninstall.

Follow the on-screen instructions to uninstall the printer driver.

Note for Mac OS X 10.3 or 10.4:
If the name of your printer remains in the Print Center or Printer Setup Utility, select the name from
Printer List and click Delete.

Using Your Software 22
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Chapter 2
Paper Handling

Using Special Paper

You can achieve good results with most types of plain bond paper. However, coated papers
provide superior printouts because they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet printers, and
recommends these papers to ensure high-quality results.

= See “Paper, Consumables, and Options” on page 203.

When loading special paper distributed by Epson, read the instruction sheets packed with the
paper first and keep the following points in mind.

Note:

d Load the paper into the rear sheet feeder printable side up. The printable side is usually whiter or
glossier. See the instruction sheets packed with the paper for more information. Some types of
paper have cut corners to help identify the correct loading direction.

L Ifthe paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing
on curled paper may cause ink to smear on your printout.

Note for Professional Flyer Paper:
[ If water gets on the printable side, wipe off the water. Be careful not to scuff or scratch the
printable side.

[ Do not touch the printable side. Moisture and oils from your skin can affect print quality.

[ Professional Flyer Paper supports 2-sided printing. When you use the 2-sided printing function,
feed the paper manually.

Paper Handling 23
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' When you use the 2-sided printing function, let the printed side dry for about 20 minutes before

printing the back side.

' When you use the 2-sided printing function, printing the low print duty side first is recommended.

Depending on the print pattern, marks made by the rollers may appear on the printed side. Print

one test copy and examine the results before printing many sheets.

d Depending on the printing environment, the output paper cannot be stacked. In this case, use the

output support tray.

Output support tray stacks 50 sheets of 1-sided printing and 25 sheets of 2-sided printing.

= See “Setting output support tray for Epson Professional Flyer Paper” on page 33.

Loading capacities for Epson special media

Refer to the table below for the loading capacities of Epson special paper and other media.

Front paper cassette:

Media Type Loading Capacity
Epson Bright White Ink Jet Paper Up to 400 sheets
(Plain Paper) Up to 500 sheets

Rear sheet feeder:

Media Type Loading Capacity
1-sided Printing Manual 2-sided Printing
Epson Bright White Ink Jet Paper Up to 100 sheets Up to 70 sheets
Epson Professional Flyer Paper Up to 70 sheets Up to 50 sheets
Epson Photo Paper Up to 60 sheets -
Epson Matte Paper-Heavyweight Up to 60 sheets -
Epson 2-sided Matte Paper Up to 1 sheet Up to 1 sheet
Epson Photo Quality Ink Jet Paper Up to 100 sheets -
Envelopes Up to 15 sheets -
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Media Type Loading Capacity

1-sided Printing Manual 2-sided Printing
Thick Plain Bond Paper Up to 20 sheets -
(Plain Paper) Up to 150 sheets “1"2 Up to 70 sheets 12

1 You can only load one sheet of legal-size paper without the optional legal-size paper support. For the maximum
loading capacity of the optional legal-size paper support, see the documentation that comes with the support.

*2You can only load one sheet of custom-size paper.

Note:
If the paper is curled, flatten it or curl it slightly in the opposite direction. Make sure the paper stack
fits under the = arrow mark inside the edge guide.

Storing Epson photo paper

Return unused paper to the original package as soon as you finish printing. Epson recommends
storing your printouts in a resealable plastic bag. Keep them away from high temperature,
humidity, and direct sunlight.

Loading Paper

Follow these steps to load paper:
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Into the front paper cassette

1. Pull out the front paper cassette.

Note:
If the optional legal-size paper cassette is attached as the front paper cassette, raise its cover and

flip it open.

2. Slide the edge guides while pinching their knob to accommodate the paper you are loading.

3. Fana stack of paper, then tap it on a flat surface to even the edges.

4. Load the paper with the printable side down.
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Note:
Avoid adding paper before running out of paper. Doing so may prevent the paper from feeding
smoothly.

Note:
If the optional legal-size paper cassette is attached as the front paper cassette, close its cover.

5. Slide the edge guides while pinching their knob to fit the paper you are loading.

»
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6. Reinsert the cassette into the printer.

Note:
Do not insert the front paper cassette with force. Doing so may cause the paper to jam.

[ Do not move the edge guides after reinserting the front paper cassette. Doing so may cause the
paper to jam.

7. Slide out and extend the extension tray.

Note:
[ Leave enough space in front of the printer for the paper to be fully ejected.

(d Make sure the paper stack fits under the = arrow mark inside the left edge guide.
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Into the rear sheet feeder

1. Open the paper support.

4. Fan a stack of paper, then tap it on a flat surface to even the edges.
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5. Load the paper with the printable side up, against the right side of the rear sheet feeder. Then
slide the left edge guide against the left edge of the paper.

Note:
d Leave enough space in front of the printer for the paper to be fully ejected.

1 Always load paper into the rear sheet feeder short edge first, even when you are printing
landscape-oriented pictures.

1 Avoid adding paper before running out of paper. Doing so may prevent the paper from feeding
smoothly.

A Mabke sure the paper stack fits under the = arrow mark inside the left edge guide.
[ If you use the optional legal-size paper support, you can load plural sheets of plain legal-size paper.

d  Even if the legal-size paper support is attached, do not leave legal-size paper in the rear sheet
feeder when you are not printing, or the sheets may curl.

Loading Envelopes

Follow these steps to load envelopes:
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1. Open the paper support.
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4. Load envelopes short edge first with the flap facing down and to the left. Then slide the left
edge guide against the left edge of the envelopes.

Note:

[ The thickness of envelopes and their ability to fold vary widely. If the total thickness of the stack
of envelopes exceeds 15 mm, press down on the envelopes to flatten them before loading. If print
quality declines when a stack of envelopes is loaded, load one envelope at a time.

You can load up to 15 envelopes at a time in the rear sheet feeder.
Do not use envelopes that are curled or folded.

Flatten the envelope flaps before loading.

IR A WA N

Flatten the leading edge of the envelope before loading.
[ Avoid using envelopes that are too thin, as they may curl during printing.

For printing instructions, see the following instructions.
= See “Printing on Envelopes” on page 43.
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Setting Output Tray

The output tray is located on the front paper cassette. Slide out the extension tray and then open
the flap on the extension tray to prevent your prints from slipping off the printer.

Setting output support tray for Epson Professional Flyer Paper
When you print on the Epson Professional Flyer Paper, set the output support tray. The use of the
output support tray is recommended especially when the output paper is curled and cannot be

stacked. Follow these steps to set the output support tray.

1. Pull out the output tray.

2. Slide the output support tray until it clicks. The output support tray is lifted slightly.
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3. Reinsert the output tray into the printer.

Note:

After printing on the Epson Professional Flyer Paper, push the output support tray to move it to its

original position.

Selecting the Correct Paper Type

The printer automatically adjusts itself for the type of paper you select in your print settings. That
is why the paper type setting is so important. It tells your printer what kind of paper you are using
and adjusts the ink coverage accordingly. The table below lists the settings you should choose for

your paper.

For this paper

Select this paper type setting

Plain paper

Epson Bright White Ink Jet Plain Paper

plain papers

Epson Professional Flyer Paper

Epson Professional Flyer

Epson Photo Paper

Epson Photo
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For this paper Select this paper type setting

Epson Matte Paper - Heavyweight Epson Matte

Epson Double-sided Matte Paper

Epson Photo Quality Ink Jet Paper Epson Photo Quality Ink Jet
Envelopes Envelope
Note:

The availability of special media varies by location. For the latest information on media available in
your area, contact Epson support.

= See “Technical Support Web Site” on page 190.
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Chapter 3
Basic Printing

Introduction

This section guides you through the procedures for different kinds of printing.

Printing Documents

Explains how to print documents on various types of paper.
= See “Printing Documents” on page 37.

ﬁ—‘

=k @

Printing on Envelopes

Explains how to print on envelopes.
= See “Printing on Envelopes” on page 43.
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Printing Web Pages

Explains how to print Web pages so that they fit on a sheet of paper without getting cut off on the
right side.
= See “Printing Web Pages” on page 49.

= es m

Printing Photos

Explains how to print photos on various types of paper.
= See “Printing Photos” on page 52.

Printing Documents
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Loading paper

Refer to the section below for details on loading paper.

= See “Loading Paper” on page 25.

When using special Epson paper, refer to the section below.

= See “Using Special Paper”

on page 23.

Printer settings for Windows

1.

Open the file you want to print.

2. Access the printer settings.

= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXXX Printing Preferences

| Shurlm* & Advanced | (7] PageLayout | o~ Maintensnce

Quality Option
Fi | L = |
= »
- B e
) Draft (®Text () Teet B Image  ()Graphic () Fhobo
Paper Optons Frink, Dptions
- Reverss Order
e [Pty (@) [sines | || B
Type | plain papers @ [ Grayscala
see [m210x297mm () [Clquetmode
2-sided printing
(ol
O duto
Ink Lavels Orientation
_"' -I (%) Portrait
| () Landscaps
[] Show this screen First
| ResetDefauks | | Technical Support |
o) cence ]
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3. Click the Main tab, then select one of the following Quality Option settings:

(J Draft for rough drafts with reduced print quality
[ Text for text-only documents with higher text quality
d Text & Image for higher quality documents with text and images

4. Select the paper source as the Source setting.
5. Select the appropriate Type setting.
= See “Selecting the Correct Paper Type” on page 34.

6. Select the appropriate Size setting. You can also define a custom paper size. For details, see the
online help.

7. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
8. Click OK to close the printer settings window.

9. Print your file.

Printer settings for Mac OS X 10.5
Follow these steps to adjust your printer settings.
1. Open the file you want to print.

2. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: | EPSON XXXXX T]@
Presets: | Standard ?]
(@ ( poFw ) ( Preview ) (" Cancel ) (Print)

3. Click the ¥ button to extend this dialog.
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4. Select the printer you are using as the Printer setting, and then make suitable settings.

Printer: | EPSON XXXXX ) ()
Presets: | Standard (+)
Copies: D # Collated
Pages: &) All
(O From: |1 to: |1
Paper Size: | A4 %] 2100y 29.70 cm
Orientation: | ﬂ ‘l # | scale: 100%
—————— Preview OB

i Automatically rotate each page

B Mo automatic page scaling
(") Scale each page to fit paper
G Only scale down large pages

\
{_Eancel ) E—Hnt-a

Note:
Depending on your application, you may not be able to select some of the items in this dialog. If
so, click Page Setup on the File menu of your application, and then make suitable settings.
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5. Select Print Settings from the pop-up menu.

Printer: | EPSON XXX ] [s)
Presets: | Standard "9']
Copies: ™ Collated
Pages: =) All
(_"',.me' 1 to: |1
Paper Size: | b2l z1.00 oy 29.70 ¢m
Orientation: ” ] Scale: 100 %
| Print Settings w

Page Setup: Standard

Paper Source: | Front Tray m
Media Type: | plain papers i+
Color: | Color B
Made: (=) Automatic Quality = ! Speed
Dﬁdﬂmed
Print Quality: | Fine

L Tl High Speed
- \
1 Mirror Image
-\ a
Chus

et Mode

&

I:Eanl:el 1

6. Make the settings that you want to use to print. See online help for details of Print Settings.

= See “Selecting the Correct Paper Type” on page 34.

7. Click Print to start printing.

Printer settings for Mac OS X 10.3 or 10.4

1. Open the file you want to print.

2. Access the Page Setup dialog.
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= See “Accessing the printer driver for Mac OS X” on page 17.

Settings: | Page Attributes ¢

Eormat for: | EPSON XOO00X Jo
i

Paper Size: | A4 b
i

21.00 cm x 29.70 em

S
1
i le

Orientation: 'G_' 'l-

Scale: 100%

(i} ( Cancel ) |ES0K59)

3. Select the printer you are using as the Format for setting, and then make suitable settings.

4. Click OK to close the Page Setup dialog.
5. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: = EPSON JOOUCX

Presets:  Standard

Copies & Pages

elle

Copies: I . ECﬂllated
Pages: ) All
_JFrom: 1 ta: |1
(7) ([ PoFw ) ( Preview ) { Cancel ) Sprinte)

6. Select the printer you are using as the Printer setting. Then make the Copies & Pages settings.

Basic Printing 42



B-310N/B-510DN  User’s Guide

7. Select Print Settings from the pop-up menu.

p— D ———

Printer: | EPSON XXXXX

Presets: ’Suﬂaal'd -

) (@ (&

- Print Settings

Page Setup: Standard i)
Paper Source: " Front Tray

(3]
o

Media Type: [ plain papers
Color: | Cu-lor

Mode: 'B Automaric
) Advaneed

Quality T %! Speed

Print Quality: | Fine v

* f High Speed
! | | Mirror Image
!| I Quler Mode

(#) (PoFv ) ( Preview )

{ Cancel jl

8. Make the settings that you want to use to print. See online help for details of Print Settings.

= See “Selecting the Correct Paper Type” on page 34.

9. Click Print to start printing.

Printing on Envelopes
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Loading envelopes

Refer to the section below for loading envelopes.
= See “Loading Envelopes” on page 30.
Refer to the section below for the printable area.

= See “Printable area” on page 207.

Printer settings for Windows

1. Access the printer settings.

= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXXX Printing Prefercnces

|2y Shortcuts [ 0 Main | @5 Advanced | (1) Page Lavout |+~ Mairtenance

Qually Cption
| Ll -
. =| ta
= B

Mad
s

o)

) Draft @ Test (O Tet & Image (CGraphic () Phobo

Faper Options

Type |Enwelope

P O

Friek, Opliors
[#] Reverse Order
[C] Print Praview

Drayscde

Size |Envelope #1014 1/8x9 1/2in

(-.:.‘h Cuist Mode =

'L

| messtDefauks | | Techrical Support |

2-gidad printing
) off

Auto

Orlenkation
) Portrait

[#] Shew this scresn First

Lok J|conest ]| ol
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2. Click the Main tab, then select one of the following Quality Option settings:

[ Text for most envelopes
[ Text & Image to print images on the envelope

3. Select Rear Tray as the Source setting.
4. Select Envelope as the Type setting.

5. Select the appropriate envelope size from the available Size settings. You can also define a
custom size. For details, see the online help.

6. Select Landscape as the Orientation setting.
7. Click OK to close the printer settings window.

8. Print your envelope.

Printer settings for Mac OS X 10.5

Follow these steps to adjust your printer settings.
1. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: | EPSON X000 T]@
Presets: | Standard ?]
(@ ( PoFv ) ( Preview ) (" Cancel ) { Print—)

2. Click the ¥ button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then select a suitable envelope size as
the Paper Size setting. You can also define a custom envelope size. For details, see the online help.
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4. Select Landscape as the Orientation setting.

Printer: | EPSON XXXXX &

Presets: | Standard

Copies: D ™ Collated

Pages: (®) All
D Frem: |1 to: |1

Paper Size: | Envelope #10 b3 1048 by 24.13 em

Orientation: | | 4 Ii >l scale: [100%

—_ Preview |"¢"l ——

gl Automatically rotate each page

'B Mo autematic page scaling
{:l Scale each page to fit paper
D Only scale down large pages

( Cancel ) (- Print)

Note:
Depending on your application, you may not be able to select some of the items in this dialog. If
so, click Page Setup on the File menu of your application, and then make suitable settings.
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5. Select Print Settings from the pop-up menu.

Printer: (EFSONIOOOIX | =)

Presets: | Standard 2
Copies: i Collated
Pages: =) All
) Frem: |1 ta: |1

Paper Size: | Envelope #10 Fe 10.48 by 24,13 cm

Orientation: || #)| Scale: | 100 %
| Print Settings @
Page Setup: Standard |
Paper Source: | Rear Tray m
Media Type: | Envelope W
Calor: [ Color (=2
Maode: (® Automatic Quality T & Speed
() Advanced
Print Quality: | Normal
s High Spaed
é Mirror Image
._—ll. Quiet Mode

[r:an:el‘l

6. Select Envelope as the Media Type setting.

7. Make other settings that you want to use to print. See online help for details of Print Settings.

8. Click Print to start printing.

Printer settings for Mac OS X 10.3 or 10.4

1. Access the Page Setup dialog.
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= See “Accessing the printer driver for Mac OS X” on page 17.

Settings: | Page Attributes ¢

Format for: EPSON XXXXX

@@

Paper Size: Envelope #10
10,48 cm x 24.13 cm

Orientation: f ¥ : “ r:: L |

Scale: 1{!096_ |

® ESE )

Select the printer you are using as the Format for setting.

Select the appropriate envelope size as the Paper Size setting. You can also define a custom
envelope size. For details, see the online help.

Select Landscape as the Orientation setting.
Click OK to close the Page Setup dialog.
Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Primter: = EPSON JOO00X (! :b

. — 4

Presets:  Standard _]'

Copies & Pages

e —

Copies: |1 # Collated

Fages: ) All :
) Frem: 1 to: 1

(7) (_POFw ) ( Preview ) ( Cancel | - Prine)
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7. Select the printer you are using as the Printer setting, then make the Copies & Pages settings.

8. Select Print Settings from the pop-up menu.

Printer: | EFSON X000

Presets:

Standard

Print Settings

Page Setup:
Paper Source:
Media Type:

Colar:

Standard
" Rear Tray

| Envelope

[ Color

Made

- i#) Auromatic

=
) Advanced

(#) ( PoFv ) ( Preview )

9. Select Envelope as the Media Type setting.

{ Cancel ) | Primt )

10. Make other settings that you want to use to print. See online help for details of Print Settings.

11. Click Print to start printing.

Printing Web Pages

Loading paper

Refer to the section below for details on loading paper.

= See “Loading Paper” on page 25.

When using special Epson paper, refer to the section below.
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= See “Using Special Paper” on page 23.

Using EPSON Web-To-Page

The EPSON Web-To-Page software lets you print Web pages so that they fit within the width of
your selected paper.

Note for Windows:
This software is not available for Windows 7, Vista, XP x64, Server 2008, and Server 2003.

Note for Windows Internet Explorer 7 or later:
Printing web pages to fit to your paper size is a standard feature in Windows Internet Explorer 7 or
later.

Note for Mac OS X:
[ This software is not available for Mac OS X.

[ Printing web pages to fit to your paper size is available by using the printer driver.

= See “Printer settings for Mac OS X 10.5” on page 39.
™ See “Printer settings for Mac OS X 10.3 or 10.4” on page 41.

1. In Internet Explorer, go to the Web page you want to print.

If you have installed EPSON Web-To-Page, the EPSON Web-To-Page toolbar appears on the
Internet Explorer window.

2. Click the Print button on the toolbar. The Print window appears.

Note:
If you want to preview the layout of your printout, click the Preview button on the toolbar.
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3. Right-click the printer icon and choose Printing Preferences in Windows XP and 2000.

& EPSON XXXXX Printing Preferences

| Shodcuts [ 8 Main | @ Advanced | (1) Page Layout| .~ Maintenance
I Quuality Option
e | e - P |
= » [l
= - i 2
) Draft O Tet (O Text&Image ()Graphic () Photo
| Paper Options Print OpLione
[#]Reverse Order
Source Fru'll:_Tra_? @ [JPrint
Type | plain papers [ rayscals
| Size A4 210 297 mm @ .
2-sided printing
(=) cff
| ) uto
| Ink Levels Orienkation
| _H -I (%) Poatrait
| ) () Landscape
[] Show this screen First
| ResstDefauks | | Technical Suppart |
o ) ooed | o

4. Click the Main tab, then select Graphic as the Quality Option settings:
5. Select the paper source as the Source setting.
6. Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on page 34.

7. Select the appropriate Size setting. You can also define a custom paper size. For details, see the
online help.

8. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
9. Click OK to close the printer settings window.

10. Print your page.
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Printing Photos

Preparing the print file
You need to adjust the image file to the size of the paper. If your application has margin settings,

make sure that the margins are within the printable area of the page.
= See “Printable area” on page 207.

Loading paper
Refer to the section below for details on loading paper.
= See “Loading Paper” on page 25.
When using special Epson paper, refer to the section below.

= See “Using Special Paper” on page 23.

Printer settings for Windows

Follow these steps to adjust your printer settings.

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXXX Printing Preferences

|y Shoeuts | S Main | @5 advanced | (7] Page Lavout | ' Mainlenance |
Cuiality Qption
I = o (i [
|- B e 9
) Draft: O Test (O Text&Image (O Graphic (3} Fhoto
Faper Opticns Priokt Oplicre
S [#] Reverse Order
rce [Reatiay () [ sevesn. || oo
Type [EnsmPl-nln [l Grayscala
Size | A4 210 % 297 mm ()  Mode
2-sided printing
(& off
Auto ChManual
Ink Levels Orlenkathon
{}L-mdstq:l-u Qﬂ{‘
[#] Shiew thiz sereen firsk
|__Resstoefauks | | Technical support |
[ ok | cenea | ceen

Click the Main tab, then select Photo in the Quality Option settings:

Select the paper source as the Source setting.

Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on page 34.

Select the appropriate Size setting. You can also define a custom paper size. For details, see the

online help.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click OK to close the printer settings window.
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After completing the steps above, print one test copy and examine the results before printing an
entire job.

Printer settings for Mac OS X 10.5

Follow these steps to adjust your printer settings.
1. Access the Print dialog.
= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: | EPSON XXXXX _T]@
B

Presets: | Standard

‘{?" PDF » (" Preview (" Cancel ) |r Print \I

2. Click the ¥ button to extend this dialog.
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3. Select the printer you are using as the Printer setting, and then make suitable settings.

Printer: | EPSON XXXXX ® &
Presets: | Standard (8]
Copies: D ™ Collated
Pages: (® All
() From: 1 to: |1

Paper Size: (10 % 15 em (4 x ... m 10.16 by 15.24 cm

Orientation: '1 | 1“ Scale: 100 %

[ Preview - —

[Ed Automatically rotate each page

e Mo autematic page scaling
O Scale each page to fit paper
(") Only scale down large pages

( Cancel ) (- Print-)

Note:
Depending on your application, you may not be able to select some of the items in this dialog. If
so, click Page Setup on the File menu of your application, and then make suitable settings.
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4. Select Print Settings from the pop-up menu.

Printer: | EPSOMN 300X

e
@

Presets: | Standard

Copies: [1 W Collated

Pages: (=) All .
O From: |1 to: |1

Paper Size: | 10 x 15 cm {4 x ... a 10.16 by 15.24 cm

Orientation: (14 19|  Scale: 100%

Print Settings @

Page Setup: Standard i)
Paper Source: | Rear Tray @
Media Type: | Epson Photo E]
Colar: | Coler e
Mode: =) Automatic

) Advanced

{ Cancel ) | {5Prines)

5. Make the settings that you want to use to print. See online help for details of Print Settings.
= See “Selecting the Correct Paper Type” on page 34.

After completing the steps above, print one test copy and examine the results before printing
an entire job.

Printer settings for Mac OS X 10.3 or 10.4

Follow these steps to adjust your printer settings.

1. Access the Page Setup dialog.
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= See “Accessing the printer driver for Mac OS X” on page 17.

Settings: | Page Attributes H

&

Format for: | EPSON XXXXX

EPSON B-5000M (6
Paper Size: | 10 x 15 cm (4 x 6 in) N
10.16 em x 15.24 ¢m
- | T .!
QOrientation: ‘r_!_' T » | T_-d !
Scale: W
@ ( Cancel ) |[E 009

Select the printer you are using as the Format for setting, and then make suitable settings.

3. Click OK to close the Page Setup dialog.
4. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: | EPSOM JOOOCX

Presets:  Standard

Copies & Pages

@@

Copies: i . ECullated
Pages: ) Al
_JFrom: 1 to: |1
(7) (PoFv ) ( Preview ) { Cancel ) EPrine)

5. Select the printer you are using as the Printer setting. Then make the Copies & Pages settings.
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6. Select Print Settings from the pop-up menu.

Printer: | EPSON XXXXX

Presets: | Standard

Print Settings

@ =

Page Setup: Standard kT
Paper Source: = Rear Tray BI
Media Type: Epson Photo HI
Color:  Color B3
Mode: ) Automatic
7 Advanced

2

(7) (PoFv ) ( Preview i Cancel ) |- Prine)

7. Make the settings that you want to use to print. See online help for details of Print Settings.
= See “Selecting the Correct Paper Type” on page 34.

After completing the steps above, print one test copy and examine the results before printing an
entire job.

Canceling Printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the printer button

Press the T Cancel button to cancel a print job in progress.
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For Windows

When you start printing, the progress meter appears on your computer screen.

Click the Stop button to cancel printing.

M EPSON XXXXX - USBOO1

EPSON Microsoft Word - EPSON.doc

Remaining 0 sec
Page:0f1

Media Tvpe : plain papers
Paper Size : A4 210 = 297 mm

- f ‘-'.
- ]
5

[ Check Ink Levels l

| Tips | ’_ Pause ] ’_ Stop ]

Technical Support ]

Faor great resulks, make sure wou use genuine Epsan ink
cartridges,

—p [ o]

For Mac OS X

Follow the steps below to cancel a print job.

1. Click your printer icon in the Dock.

2. Inthe Document Name list, select the document which is printing.
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3. Click the Delete button to cancel the print job.

Printing "Document”.
ﬁ Sending data
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Chapter 4
Printing with Special Layout Options

Introduction

You can print with a variety of layouts for special projects, such as booklets and posters.

2-Sided Printing

Lets you print on both sides of the paper.
= See “2-Sided Printing” on page 63.

Fit to Page Printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in
the printer driver.
= See “Fit to Page Printing” on page 90.
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Note for Mac OS X:
This feature is not available for Mac OS X 10.3.

e
N

Pages Per Sheet Printing

Lets you print two or four pages on a single sheet of paper.
= See “Pages Per Sheet Printing” on page 100.

2

1

"ol 1 1
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Poster Printing (for Windows only)

Lets you enlarge material on a single document page to cover 4, 9, or 16 printed sheets of paper,

and then make a poster.

= See “Poster Printing (for Windows only)” on page 109.

L

-

ga'il
(, p \

Watermark Printing (for Windows only)

-

Lets you print text or an image as a watermark on each page of your printout.

= See “Watermark Printing (for Windows only)” on page 115.

For example, you can put “Confidential” on an important document.

2-Sided Printing

Two types of 2-sided printing are available: standard and folded booklet.

Standard 2-sided printing

Printing with Special Layout Options
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Lets you print odd- and even-numbered pages onto opposite sides of the sheet.

)y | -

For Windows, as well as automatic 2-sided printing, manual 2-sided printing is also available so
that you can print on both sides without using the duplex unit.

Manual 2-sided printing allows you to print the odd-numbered pages first. Once these pages are
printed, you can reload them to print the even-numbered pages onto the opposite side of the paper.

Folded booklet 2-sided printing

Lets you make single-fold booklets. The page that will appear on the outside (after page is folded)
is printed first. Then, the page that will appear inside the booklet is printed as shown below.

*

AN

P

Single-fold booklet

*k: Binding edge
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For Windows, as well as automatic 2-sided printing, manual 2-sided printing is also available so
that you can print on both sides without using the duplex unit.

You can create a booklet by printing pages 1 and 4 on the first sheet of paper, pages 5 and 8 on the
second sheet, and pages 9 and 12 on the third sheet.

After you reload these sheets into the rear sheet feeder, you can then print pages 2 and 3 on the
back of the first sheet of paper, pages 6 and 7 on the back of the second sheet, and pages 10 and 11
on the back of the third sheet.

The resulting pages can then be folded and bound together into a booklet.

Note:
[ Depending on the paper, stacks of up to 30 sheets can be loaded into the rear sheet feeder during
2-sided printing.

[ Only use papers that are suitable for 2-sided printing. Otherwise, the printout quality may
deteriorate.

1 Depending on the paper and the amount of ink used to print text and images, ink may bleed
through to the other side of the paper.

(A The surface of the paper may be smeared during 2-sided printing.

Standard 2-sided printing for Windows

Automatic 2-sided printing (using the duplex unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet
using the duplex unit.

Note:
1 Automatic 2-sided printing supports plain paper only.

[ Thick plain paper is not supported for automatic 2-sided printing.

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXKX Printing Preferences

[ Zr Shoncuts [ Main ] @5 Advanced | (1] Page Layout | /* Maintensnes|

Quality Option

i | Ll - |
— s [l
= B i 2
) Draft (@ Text  (OText@&Image (OGraphic () Photo
Paper Ophions Frint OpLions
r [¥] Reeverse Order
Souroe _Fmt_Tla_? @ Dﬁ'ﬂ
Type | plain papers ] Grayscals
Size :MZ[D:Z??rrm @ [[] it Mode
[ 2-sided printing
| ) o
) Buto
| Ink Leveds Orient.ation
i _H 1 (%) Portrait
] ) Landscape
[+] Shieww thiz sereen First
| Resstoefauks | | Technical Support |
[Cox_J| coma |

2. Click the Main tab, then select one of the following Quality Option settings:

(I T SR

Draft for rough drafts with reduced print quality

Text for text-only pages

Text & Image for higher quality pages with text and images
Graphic for higher quality graphics

Photo for good quality and speed

3. Select the paper source as the Source setting.

Select plain papers as the Type setting.

= See “Selecting the Correct Paper Type” on page 34.
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5. Select the appropriate Size setting.
6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, then select Auto from 2-sided printing.

& EPSON XXXXX Printing Preferences
| <7 Shoneuts | BB Main | i@ Advanced| [T Page Lapout |~ Maintensnce |

Layout Z-gided prinking
[ reduce/Enlargs Documert Ot Margins. .
By Cubpuk Paper Size (=) duto
©) Marwaal [(]Foided Booklet
Copias
Cop 1 -
[ rhti-Page G .
Reverse Order
P""'J"‘" paf Shaat 'T
Poster Printing Collate lﬁ
l_ : __| Mare Cpbions
Prirtt Page Borders [CIrotate 1507
Page Ordear,.. Dmm
Watermark
,Nme st

[ ok [ cened | el

Printing with Special Layout Options 67



B-310N/B-510DN  User’s Guide

8. Click Adjust Print Density to open the Print Density Adjustment window.

Print Density Adjustment

Select Document Type

() Texti () Text with Phota () Photo Manual

Adjustments

Print Density J (%)
-50 o
Increased Ink Dryving Time J ; IE‘ {sec)
1] &0
oK l [ Cancel ] [ Help ]

9. Select the appropriate document type as the Select Document Type setting.
10. Specify the Print Density and Increased Ink Drying Time as the Adjustments setting.

Note:
When you print data with dense photo on both sides of paper, reduce the print density and
increase the drying time to print finely.

11. Click OK to return to the Page Layout window.

12. Click Margins to open the Margins window.

Binding Edge () 1eft: O Top () Right:

Binding Margin [12 ... 118]

Uniik
()0.01 cm (3)0.01 inch

[_ QK J [gancel ] [ Help ]

13. Specify the edge of the paper where the binding will be placed. You can choose Left, Top, or
Right.
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14. Choose ecm or inch as the Unit setting. Then specify the width of the binding margin. You can
enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches.

Note:
The actual binding margin may be different from the specified settings depending on your
application. Experiment with a few sheets to examine actual results before printing the entire job.
15. Click OK to return to the Page Layout window. Then click OK to save your settings.
16. Load paper into the printer, then send the print job from your application.

= See “Loading Paper” on page 25.

Note:
Do not pull out the paper with force when the printer ejects paper after printing on one side.

Manual 2-sided printing

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet.

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXKX Printing Preferences

|2 Shotcuts [ B Main ] @5 Advanced | [T PageLayout| . Maintenance |
Quiality Optian
e L - | A
=| 3 (U
= B i 2
) Draft @ Text O Test&Image (OGraphic () Photo
Faper OpLione Frind Oplicrs
e [¥] Reverse Order
sare ooty (@) [ i ||| DR
Type [ﬂehpawrs [l Grayscals
Size | Ad 210 x 207 mn (+)  [oquetmods
Z-sided printing
&) OfF
) suto CrManual
Ink Lewels Orlenkation
| O Landscape S
[] Shew this sereen first
| Resetpefauks | | Techrical Support |
) T

2. Click the Main tab, then select one of the following Quality Option settings:

(d Draft for rough drafts with reduced print quality

Text for text-only pages

Graphic for higher quality graphics

(I T SR

Photo for good quality and speed

3. Select Rear Tray as the Source setting.

4. Select the appropriate Type setting.

Text & Image for higher quality pages with text and images

= See “Selecting the Correct Paper Type” on page 34.
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5. Select the appropriate Size setting.
6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, then select Manual from 2-sided printing.

& EPSON XXXXX Printing Preferences

| Ly Shomeuts | B Main | = M-Iar:edl (1) PageLapout |~ Mairtenence |

Lyt Z-sided printing
[[]Reduca/Erlargs Document ot e
By Cwbput Paper Size ) duto

EIFckiad Boobdet

Copias
Copies |1 =
] rhudti-Page L |
Reverse Order
p_,:.;.'..: pet Shaatl -T
Poster Printing Colate 1@
l _| Mare Cptions
Prirk: Page Borders [retate 1502
Page Order. .. DWM
Watermark
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8.

10.

11.

12.

13.

Click Margins to open the Margins window.

Binding Edge

....... O1ap

[12 B [2..ual

() Right:

Binding Margin
LInik

(0,01 em (%) 0.01 inch

I [0 4 ] ’gancel ] l Help ]

Specity the edge of the paper where the binding will be placed. You can choose Left, Top, or
Right.

Choose em or inch as the Unit setting. Then specify the width of the binding margin. You can
enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches.

Note:

The actual binding margin may be different from the specified settings depending on your
application. Experiment with a few sheets to examine actual results before printing the entire job.

Click OK to return to the Page Layout window. Then click OK to save your settings.

Load paper into the rear sheet feeder, then send the print job from your application.

Instructions for generating the even-numbered pages will be displayed while the

odd-numbered pages are printed.

= See “Loading Paper” on page 25.

Follow the on-screen instructions to reload the paper.

Note:

A The paper may curl during printing due to the amount of ink used. Should this occur, slightly
curl the sheets in the opposite direction before reloading them.

1 Align the sheet stack by tapping its edges against a hard, flat surface before reloading the stack.

Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or
the binding margins may be incorrect.

Printing with Special Layout Options 72



B-310N/B-510DN  User’s Guide

[ If a paper jam occurs, refer to the following.
= See “The Paper Jams” on page 172.

14. Once the paper is reloaded, click Resume to print the even-numbered pages.

Standard 2-sided printing for Mac OS X 10.5

Automatic 2-sided printing (using the duplex unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet
using the duplex unit.

Note:
1 Automatic 2-sided printing supports plain paper only.

A  Thick plain paper is not supported for automatic 2-sided printing.
1. Access the EPSON Printer Utility3 dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.
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2. Click the Printer and Option Information button.

chieck the level of ink remaining.

Mozzie Check

Use this utility if gaps or faint areas appear in your
printout.

EPSON StatusMonitor
Use this utility to automatically check for errors and also

Head Cleaning

! Use this utility if your print quality declines or the Nozzle
Check indicates clogged nozzles.

Print Head Alignment

AA Usa this utility if misaligned vertical lines appear in your
printout.
r_ Frinter and Option Information

= Use this utility to make or verify settings for your printer
and optional devices.
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3. Make sure that Duplexer Installed is displayed in the Auto Duplex Printing Information
section, and then click OK.

EPSON ‘gl crson oo

Qﬁ Printer Information

Aute Duplex Printing Infarmation

[0 Duplexer Installed ] { Refresh Settings )

Front Tray
Select the Media Type and Paper Size that is loaded in the Front Tray,

When Paper Source is set to Autematic, the paper source is determined
by the settings below.

If the Media Type (from the Print dialog box) and the Paper Size (from
the Page Setup dialeg box) do not match the settings below, the paper
will feed from the Rear Tray.

Media Type [ plain papers m
FaperSize [ A4 M

(" ResetDefault ) ( Apply )

=)

4. Close the EPSON Printer Utility3 dialog.
5. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: | EPSON OO l-e-q@

Presets: | Standard

(@ ( PoFw ) ( Preview ) (" Cancel ) (- Print)

6. Click the ¥ button to extend this dialog.
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7. Select the printer you are using as the Printer setting, and then make suitable settings.

Printer: | EPSON XXXXX ® &

Presets: | Standard )

Copies: D ™ Collated

Pages: (&) All
OFrom: 1 to: 1
Paper Size: | Ad % 21.00 by 29.70 cm
Orientation: I 0 1| ‘1:‘ Scale: | 100 %
[ Preview = I

i Automatically rotate each page

B Mo automatic page scaling
(") Scale each page to fit paper
O Only scale down large pages

-
I:'_Eam:el y, E—Frhﬂ—a

Note:
Depending on your application, you may not be able to select some of the items in this dialog. If
so, click Page Setup on the File menu of your application, and then make suitable settings.
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8. Select Print Settings from the pop-up menu.

Printer: | EPSOM XXXXX

Presets: | Standard )
Copies: D [ Collated
Pages: B All
O Fram: |1 to: |1
Paper Size: [ A4 b2l z1.00 oy 29.70 ¢m
Orientation: | |ﬂ! M| scate: [100%
| Print Settings @

Page Setup: Standard

Print Quality: | Fine

@\

Paper Source: [ Front Tray m
Media Type: | plain papers b
Color: | Color A
Mode: ) Automatic Quality T & Speed
() Advanced

¥ v High Speed
Mirror Imnge

Cuiler Mode

9. Select plain papers as the Media Type setting.

(oD |

10. Make other settings that you want to use to print. See online help for details of Print Settings.
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11. Select 2-sided Printing Settings from the pop-up menu.

Printer: | EPSON XXXXX =)
Presets: | Standard =]
Copies: D ™ Collated
Pages: =) All
CiFrom: 1 te: |1
Paper Size: [ A4 18 zLo0 by 29.70 em
Orientation: Ii
[ 2-sided Printing Settings =)

[ # 2-sided Printing |
Binding edge: (*) 2-sided long edge

() 2-sided short edge
L. When printing a phota or document containing a lot of solid image areas,
reduce the density of the ink and increase its drying time,

Select Dotument Type Adjusements

E @ Text Pririt Density:

_-I : O [-20m0
-

s () Text with Photo _5n o

ﬁ D Photo Increased Ink Drying Time:
- ¥ o |0 (sec)

[U ) Manual 0 +B0

=)

12. Select the 2-sided Printing check box.
13. Select the Binding edge setting.

14. Select one of the Select Document Type settings. This automatically adjusts Print Density and
Increased Ink Drying Time.

Note:
If you are printing high-density data, such as photos or graphs, we recommend adjusting the
Print Density.

15. Load paper into the printer, and click Print.

= See “Loading Paper” on page 25.
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Standard 2-sided printing for Mac OS X 10.3 or 10.4

Automatic 2-sided printing (using the duplex unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the sheet
using the duplex unit.

Note:
1  Automatic 2-sided printing supports plain paper only.

a

1.

Thick plain paper is not supported for automatic 2-sided printing.

Access the EPSON Printer Utility3 dialog.
= See “Accessing the printer driver for Mac OS X” on page 17.
Click the Printer and Option Information button.

Make sure that Duplexer Installed is displayed in the Auto Duplex Printing Information
section, and then click OK.

Close the EPSON Printer Utility3 dialog.
Access the Page Setup dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Settings: | Page Attributes l-&4

Format for: EPSON XXXXX 1 l

w !

o

Ld
Paper Size: = Ad (- !l
e

21.00 cm x 29.70 ¢m

Orientation: ’E I!- I-'l

Scale: 100%

i '-_" ( Cancel ) |E0K9)
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6. Select the printer you are using as the Format for setting.

7. Select A4, Letter, or B5 as the Paper Size setting.

8. Select the appropriate Orientation setting, and click OK to close the Page Setup dialog.
9. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: | EPSON JOOCKX

Presets: | Standard

@&

" Print Settings

Page Setup: Standand

Paper Source: [ Front Tray

Media Type: [ plain papers
Color: | Color

Mode: Efl Automanc Quality -—ﬂ}l . 5|:|-eed
) Advanced

Print Chuality: © Fime

(7) (_POF¥ ) ( Preview ) { Cancel )

10. Select Print Settings from the pop-up menu.
11. Select plain papers as the Media Type setting.

12. Make the settings that you want to use to print. See online help for details of Print Settings.
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13. Select 2-sided Printing Settings from the pop-up menu.

& &

Printer: | EPSON JO0(KX

Presets: Standard

f 2-sided Printing Settings |
[ # 2-sided printing |
Binding edge: (#) 2-sided long edge

() 2-sided short edge

L. When priming a phote o document contalning a box of solid image areas.,
reduce the density of the ink and Increase its drying time.

|0 |{seq)

Select Document Type Adjustnents
— ) Text Print Drensity:
- = = 20 )
.I"': ) Text with Photo -50 0
ﬁ ) Photo Increased Ink Drying Time

o +60

(#) ( POFw ) ( Preview ) { Cancel )

14. Select the 2-sided Printing check box.
15. Select the Binding edge setting.

16. Select one of the Select Document Type settings. This automatically adjusts Print Density and
Increased Ink Drying Time.

Note:
If you are printing high-density data, such as photos or graphs, we recommend adjusting the
Print Density.

17. Load paper into the printer, and click Print.

= See “Loading Paper” on page 25.
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Folded booklet 2-sided printing (for Windows only)

Automatic 2-sided printing (using the duplex unit)

Note:

[ Automatic 2-sided printing supports plain paper only.

[ Thick plain paper is not supported for automatic 2-sided printing.

Use the following steps to create a folded booklet using the duplex unit.

1. Access the printer settings.

= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXKX Printing Preferences

| & Ehrlu.ls W5 Advanced | (1] PageLayout| o~ Maintsnance
Quality Option
A = o e
o= - Uad
== B o= Friak
) Draft (@ Text  (OText@&Image (OGraphic () Photo
Faper Options T, Cphiones
[¥] Reverse Order
Source | Front Tr
y @ [ Priit Praview
Type |plain papers [ Grayscala
Size | Ad 210 x 297 mm @ [[] it Mode
2-sided printing
[ol:;
'C"Ml:l
Ink Lewels Orienkation
— —
_u -I @ Portrait
) Landscapa
Shiow this sereen firsk
| Resstoefauks | | Technical Support |
k][ cenca |

2. Click the Main tab, then select one of the following Quality Option settings:

[ Draft for rough drafts with reduced print quality
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[ Text for text-only pages

J Text & Image for higher quality pages with text and images
d Graphic for higher quality graphics

d Photo for good quality and speed

Select the paper source as the Source setting.

Select plain papers as the Type setting.

= See “Selecting the Correct Paper Type” on page 34.
Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.
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7. Click the Page Layout tab, select Auto from 2-sided printing, then select the Folded Booklet

check box.

8. Click Adjust Print Density to open the Print Density Adjustment window.

& EPSON 20000 Printing Preferences
| Oy Shoeuts | B Main | 24 .ﬁ.d'dr:edl (1) Page Layout | Maintenance |

Layiout Z-sided prisking
[ reduce/Enlargs Document O off I Margns. ..

By Oubpuk Paper Size =) futo

O Mot

ByPercertage | 13| % [ Adjust Print Dery...

]

Copies | 1 =
Chati-Page ssecele]

Reverse Order

[ e
Prirt Page Borders DR:*“H gzl
Fage Crder... ||| [C]Mirer Tmage
Watermark
Nere |

. .
Pages per Shest CWErst L 'T
Poster Printing | Coldate 1@

C o J[ comes ]| cgob

Print Density Adjustment

Select Document Type

(®Text! () Text with Photo () Phota ranual

Adjustments

Print Densiky J (%)
-50 1]

Increased Ink Drving Time v IE‘ (sec)
1] 60

L ok ] [ Cancel ] [ Help ]
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9. Select the appropriate document type as the Select Document Type setting.

10. Specify the Print Density and Increased Ink Drying Time as the Adjustments setting.

11.

12.

13.

Note:

When you print data with dense photo on both sides of paper, reduce the print density and

increase the drying time to print finely.

Click OK to return to the Page Layout window.

Click Margins to open the Margins window.

BindngEdge  (®iefft (O Top () Right
Binding Margin 1z @ [iz..118]
Uik
(0,01 em (%) 0.01 inch
I [0 4 ] l Zancel ] l Help ]

Specify the edge of the paper where the binding will be placed. You can choose Left, Top, or

Right.

Note:

When you select Portrait as the Orientation setting, the Left or Right binding positions are
available. The Top binding position is available when you select Landscape as the Orientation

setting.

14. Choose cm or inch as the Unit setting. Specify the width of the binding margin.
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> 5 Al

Portrait Landscape

*:Folding edge
**: Margin

You can enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches. The
specified margin width will be used on both sides of the fold. For example, if you specify a 1 cm
margin, you will get a 2 cm margin (a margin of 1 cm will be placed on each side of the fold).
15. Click OK to return to the Page Layout window. Then click OK to save your settings.
16. Load paper into the printer, then send the print job from your application.

= See “Loading Paper” on page 25.

Note:
Do not pull out the paper with force when the printer ejects paper after printing on one side.

17. Once printing is complete, fold the sheets and bind them together using a stapler or other
binding method.

Manual 2-sided printing

Use the following steps to create a folded booklet.

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXXX Printing Preferences

| Zr Shortcuts [ 8 Main | g Advanced | (1] PageLayout| . Maintenance
Quality Qption
d - A -
=l 3 (Ui
= B i 2
) Draft @ Tet O Tet&Image (OGraphic () Photo
Faper Oplions Frink Dplions
TR [#]Reverse Order
S O I
Typs [ﬂei'lpawrs [l Grayscae
Size | Ad 210 x 297 mm (~)  [ouetrode
Z-sided printing
(&) of
) Buto ChManual
Ink Levels Orienkakion
| ' Landscape S
[]5hew this sereen First
| mesetDefauks | | Technical Suppart |
Cor | oo ] oo

2. Click the Main tab, then select one of the following Quality Option settings:

(d Draft for rough drafts with reduced print quality

Text for text-only pages

Graphic for higher quality graphics

(I T SR

Photo for good quality and speed

3. Select Rear Tray as the Source setting.

4. Select the appropriate Type setting.

Text & Image for higher quality pages with text and images

= See “Selecting the Correct Paper Type” on page 34.
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Select the appropriate Size setting.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab, select Manual from 2-sided printing, then select the Folded

Booklet check box.

& EPSON 20000 Printing Preferences

| 2 Shotcuts | @ Main | @ Advanced| [T Pags Layout | # Mairtenance|
Layiout Z-sided prinking
sl St ()
By Oubpuk Paper Size ) futo
By Per I:l Fa Adjusk Print Densty, ..
Copias
Cop 1 =
Clmulti-Fage opies | _
H ree Order
Pages | t T
Poster Printing Collate . :ﬁ
l | Maore Options
Prirt Page Bordar DR“EH 150"
Pag [Csirror Image
Watermark
Mere v
Co J[oe )
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8. Click Margins to open the Margins window.

Binding Edge

Binding Margin
Lnik

(0,01 cm

_______ Tof ) piight
[1Z ... 18]

(=)0.01 inch

Lo |

[ Cancel l [ Help l

9. Specify the edge of the paper where the binding will be placed. You can choose Left, Top, or

Right.

Note:

When you select Portrait as the Orientation setting, the Left or Right binding positions are
available. The Top binding position is available when you select Landscape as the Orientation

setting.

10. Choose ecm or inch as the Unit setting. Specify the width of the binding margin.

j?//\r\\ia‘
> o A

Portrait

*:Folding edge
**: Margin

Landscape
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You can enter any width from 0.3 cm to 3.0 cm, or from 0.12 inches to 1.18 inches. The
specified margin width will be used on both sides of the fold. For example, if you specify a 1 cm
margin, you will get a 2 cm margin (a margin of 1 cm will be placed on each side of the fold).

11. Click OK to return to the Page Layout window. Then click OK to save your settings.

12. Load paper into the rear sheet feeder, then send the print job from your application.
Instructions for printing the inside pages will be displayed while the outside pages are printed.

= See “Loading Paper” on page 25.
13. Follow the on-screen instructions to reload the paper.
Note:
 The paper may curl during printing due to the amount of ink used. Should this occur, slightly

curl the sheets in the opposite direction before reloading them.

1 Align the sheet stack by tapping its edges against a hard, flat surface before reloading it in the
printer.

Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or
the binding margins may be incorrect.

1 Ifa paper jam occurs, refer to the following.
= See “The Paper Jams” on page 172.

14. Once the paper is reloaded, click Resume to print the inside pages.

15. Once printing is complete, fold the sheets and bind them together using a stapler or other
binding method.

Fit to Page Printing

You can use the Fit to Page printing function when you want to print, for example, an A4 size
document on another size paper.
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Fit to Page printing automatically resizes your page to the paper size you select. You can also resize
your page manually.

Printer settings for Windows

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXXX Printing Preferences

| 2r Shorcuts [ Main | @ Advanced || [1] Page Layout | .~ Maintenance
Cuality Qption
| Ll - P
= s [l
- B - G )
) Draft @ Tet (O Text&Image (OGraphic () Photo
Faper Dptions Frink Ophions
- R Order
Source |Fronk Tray @ E;:“
Type | plain papers [ rayscals
Size :mz'lnxzq?m @ [ st Mode
2-sided printing
@ off
) Auto
Ink Levels Orlentakion
_H -I (%) Poatrait
] ) Landscape
[] Shew this sereen First
| ResstDefauks | | Technical Suppart |
C_ox_J|[ come |

2. Click the Main tab, then select one of the following Quality Option settings:

Text for text-only pages

Graphic for higher quality graphics

(I T SR

Photo for good quality and speed

Select the paper source as the Source setting.
Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on

Draft for rough drafts with reduced print quality

Text & Image for higher quality pages with text and images

page 34.
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5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, then select the Reduce/Enlarge Document check box.

& EPSON XH0EK Printing Preferences

|27 Shoneds | @& Main| 5 Advanced [ (1) Pags Lagout | 7 Maintenance |

Lavgut
[+] Rieduce/Enlargs Document ]

By Cutpuk Papar Size
|4 210 % 297 men v

Ovypucriare [77_7]

] hudti-Psge

Watermark

Z-sided prinking
(=) otf

) duto

O Folded Bookdet

Adjust Print Dens

Copis

Copies | 1 -
[ Reverse Order

Dcotas (HH

Mare Opbions
[rotate 150°
[CIrrrer Image

8. Do one of the following:

[ Ifyou selected By Output Paper Size, select the size of the paper you are using from the

drop-down list.

[ Ifyou selected By Percentage, use the arrows to choose a percentage.

9. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an

entire job.
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Printer settings for Mac OS X 10.5

1. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: | EPSON XXXXX |¢1®
Presets: | Standard B
@ ( PDF¥ ) ( Preview ) ( Cancel ) (- Print)

2. Click the ¥ button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then make suitable settings.

Printer: | EPSON XXXXX @) )
O)

Presets: | Standard

Copies: f 1 ™ Collated

Pages: (@ All
() From: |1 to: |1
Paper Size: | A4 %] 21.00by29.70cm

-~ B
Orientation: || i| [To|  scale: 100%

| Preview e

) Automatically rotate each page

e Mo automatic page scaling
O Scale each page to fit paper
C- Only scale down large pages

{Eam:el ) f—i‘rim—a

Note:
Depending on your application, you may not be able to select some of the items in this dialog. If
so, click Page Setup on the File menu of your application, and then make suitable settings.
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4. Select Paper Handling from the pop-up menu.

Printer: | EPSON XXOOIX W =)
Presets: | Standard 1
Copies: (1| M Collated
Pages: = Al
OFrom: (1 to: 1
PaperSize: [ A4 P8 21.00 by 29.70 em

Orientation: [ &1 19|  scale: T00%

S

| Paper Handling Ll-é-j
Pages To Print: | All pages m
Destination Paper Size: | Suggested Paper: Ad ]

Scale to fit paper size |
Scale down only

Page Order: | Automatic E

| Cancel | fm‘

5. Select the Scale to fit paper size.

6. Make sure that the appropriate size is displayed in Destination Paper Size.
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7. Select Print Settings from the pop-up menu.

Printer: | EPSON XXX ] [s)
Presets: | Standard "9']
Copies: ™ Collated
Pages: =) All
(_"',.me' 1 to: |1
Paper Size: | b2l z1.00 oy 29.70 ¢m
Orientation: ” ] Scale: 100 %
| Print Settings w

Page Setup: Standard

Paper Source: | Front Tray m
Media Type: | plain papers i+
Color: | Color B
Made: (=) Automatic Quality = ! Speed
Dﬁdﬂmed
Print Quality: | Fine
4 vl High Spesd
£ Mirror Image
——ll‘l Quiet Mode

&

I:Eanl:el 1

8. Make the settings that you want to use to print. See online help for details of Print Settings.

= See “Selecting the Correct Paper Type” on page 34.

After completing the steps above, print one test copy and examine the results before printing an

entire job.

Printer settings for Mac OS X 10.4

1. Access the Page Setup dialog.
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= See “Accessing the printer driver for Mac OS X” on page 17.

Settings: | Page Attributes

Format for: | EPSON JO00CX

@

Paper Size: A4
21.00 cm x 29.70 cm

— e
Orientation: 1[;_' Tse T

Scale: 100%

G

@ ( Cancel ) |ES0K59)

Select the printer you are using as the Format for setting and then make suitable settings.

Click OK to close the Page Setup dialog.
4. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: = EPSON JOOUCX

Presets:  Standard

Copies & Pages

elle

Copies: I ] ECﬂllated
Pages: ) All :
_JFrom: 1 ta: |1
(7) ([ PoFw ) ( Preview ) { Cancel ) Sprinte)

5. Select the printer you are using as the Printer setting, then make the Copies & Pages settings.
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6. Select Paper Handling from the pop-up menu.

Printer: | EPSON XXOO(X 9
Presets: _Standard _:]'
Paper Handling )
Page Order: ) Automatic Print: ) All Pages
") Normal ) Ddd numbered pages
T Reverse ) Even numbered pages

Destination Paper Size:
) Use documents paper size: Ad
[@ Scale to fit paper size: Ad 3 ]
1 Scale down only

':.:ﬂ' l.: POFw | [ Preview | L Cancel 3 E ﬂ"lﬂla

7. Select Scale to fit paper size as the Destination Paper Size.

8. Select the appropriate paper size from the pop-up menu.
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9. Select Print Settings from the pop-up menu.

Printer: | EPSOMN 30000

3

Presets:  Standard

Print Settings

Page Setup: Standard
Paper Source: | Front Tray

(

Media Type: plain papers
Color:  Color

Mode: E Automatic Qualinr — Speed
) Advanced

o

Print Quality: Norma

il High Speed

E 1 Mirror Image
!| Quiet Mode

(#) (POFw ) ( Preview ) { Cancel )| EPrint=)

10. Make the settings that you want to use to print. See online help for details of Print Settings.

= See “Selecting the Correct Paper Type” on page 34.

After completing the steps above, print one test copy and examine the results before printing an
entire job.
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Pages Per Sheet Printing

Pages Per Sheet printing allows you to print two or four pages on single sheets of paper.

12y
X ol

75 :

Printer settings for Windows

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXXX Printing Preferences

| 2r Shorcuts [ B Main ) i@ Advanced | [1] Page Layout| . Maintenance
Cuality Qption
| Ll - P
= s [l
- B - G )
) Draft @ Tet (O Text&Image (OGraphic () Photo
Faper Dptions Frink Ophions
- R Order
Source |Fronk Tray @ E;:“
Type | plain papers [ rayscals
Size :mz'lnxzq?m @ [ st Mode
2-sided printing
@ off
) Auto
Ink Levels Orlentakion
_H -I (%) Poatrait
] ) Landscape
[] Shew this sereen First
| ResstDefauks | | Technical Suppart |
C_ox_J|[ come |

2. Click the Main tab, then select one of the following Quality Option settings:

Text for text-only pages

Graphic for higher quality graphics

(I T SR

Photo for good quality and speed

3. Select the paper source as the Source setting.
4. Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on

Draft for rough drafts with reduced print quality

Text & Image for higher quality pages with text and images

page 34.
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5. Select the appropriate Size setting.
6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, select Multi-Page, then select Pages Per Sheet.

& EPSON XH00K Printing Preferences

| %7 shoneus | @& Main| 5 Advanced 7 Maintenancs |
L arosk Z-sided prinking
[ reduce/Enlargs Documenrt (=) of
By Cutpuk Papar Size ) duto
Om Folded Booket
By Perientags : Sdjusk Prink Dersty, ..
Copis
Ciaps 1 ¥
[E‘Fbﬂﬂp&'?ﬂt ] [IReverse Order @@@
) Poster Printing Iﬂi [ collate
[z B Mare Optiorns
[lprirk Page Borders ClRetete 180°
Page Order... | [Mirrer Image
Watermark
Moo v
C ok J|Ccome ] oo

8. Select from the following settings for Pages Per Sheet printing:

2,4 Prints two or four pages of your document on a single piece of paper.

Print Page Prints frames around the pages printed on each sheet.

Borders

Page Order Allows you to specify the order in which the pages will be printed on the sheet of
paper. Some settings may be unavailable, depending on the Orientation setting
on the Main window.

9. Click OK to close the printer settings window.
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After completing the steps above, print one test copy and examine the results before printing an
entire job.

Printer settings for Mac OS X 10.5

1. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: [ EPSON XXXXX I—%—]@
4

Presets: | Standard

@ -.:_ PDF v ) " Preview | " Cancel ) ( Print }

2. Click the ¥ button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then make suitable settings.

Printer: | EPSON XXXXX ® &
Presets: | Standard ®)
Copies: I:I: I ™ Collated
Pages: (® All
() From: |1 to: 1
Paper Size: | A4 8 21.00by29.70cm
Orientation: Il1| |I: Scale: 100%

| Praview H

i Automatically rotate each page

B Mo automatic page scaling
C} Scale each page to fit paper
C} Only scale down large pages

':Eam:el ) f—i‘rlrlt'-'a

Printing with Special Layout Options 103



B-310N/B-510DN  User’s Guide

Note:
Depending on your application, you may not be able to select some of the items in this dialog. If
so, click Page Setup on the File menu of your application, and then make suitable settings.

4. Select Layout from the pop-up menu.

Printer: | EPSON 2000 3] fa
Presets: | Standard =]
Copies: 1 | # Collated
Pages: () All : :
() From: |1 to: |1
Paper Size: A4 TI‘ 2100 by 29.70 cm
Orientation: “ # | e Scale: 100%

®

Pages per Sheet: 2 ﬂ
Layout Direction: | 2 | S H N
Border: | Mone 3

|_'Reverse Page Orientation

(" Cancel ) —Print—)

5. Select from the following settings:

Pages per Sheet Prints multiple pages of your document on a single piece of paper.

You can choose from 1, 2,4, 6,9, or 16.

Layout Allows you to specify the order in which the pages will be printed on the sheet of
Direction paper.
Border Prints a border around the pages printed on each sheet. You can choose from

None, Single Hairline, Single Thin Line, Double Hairline, or Double Thin Line.
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6. Select Print Settings from the pop-up menu.

Printer: | EPSOM XXX ==
Presets: | Standard 2 )
Copies: M Collated
Pages: (= All
Gmm- 1 to: |1
Paper Size: | e 21.00 oy 29.70 ¢m

Orientation: i ’ Scale: 100 %
| Print Settings w

Page Setup: Standard ﬁ
Paper Source: | Front Tray m
Media Type: | plain papers =
Color: [ Calor =
Maode: (=) Automatic Quality T Speed
() Advanced

Print Quality: | Fine

a* ¥ High Speed
= 1
i Mirror Image
| o
Chu

et Mode

w

[ Cancel )

7. Make the settings that you want to use to print. See online help for details of Print Settings.

= See “Selecting the Correct Paper Type” on page 34.

After completing the steps above, print one test copy and examine the results before printing an
entire job.

Printer settings for Mac OS X 10.3 or 10.4

1. Access the Page Setup dialog.
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= See “Accessing the printer driver for Mac OS X” on page 17.

Settings: | Page Attributes

Format for: | EPSON JO00CX

@

Paper Size: A4
21.00 cm x 29.70 cm

— e
Orientation: 1[;_' Tse T

Scale: 100%

G

@ ( Cancel ) |ES0K59)

Select the printer you are using as the Format for setting, and then make suitable settings.

Click OK to close the Page Setup dialog.
4. Access the Print dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.

Printer: = EPSON JOOUCX

Presets:  Standard

Copies & Pages

elle

Copies: I ] ECﬂllated
Pages: ) All :
_JFrom: 1 ta: |1
(7) ([ PoFw ) ( Preview ) { Cancel ) Sprinte)

5. Select the printer you are using as the Printer setting, then make the Copies & Pages settings.
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6. Select Layout from the pop-up menu.

Printer:  EPSON X000

Presets: | Standard

@@ &

Layout

Pages per Sheet:| 2 _=]
Layout Direction: ’?' S H N
1 2 Border: Mone ﬂ

,;?'_. POF v ) [ Preview (" Cancel ) (—E}

7. Select from the following settings:

Pages per Sheet Prints multiple pages of your document on a single piece of paper. You can
choosefrom1,2,4,6,9,0r 16.

Layout Allows you to specify the order in which the pages will be printed on the sheet of
Direction paper.
Border Prints a border around the pages printed on each sheet. You can choose from

None, Single Hairline, Single Thin Line, Double Hairline, or Double Thin Line.
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8. Select Print Settings from the pop-up menu.

Printer: = EPSON X000X

4 3

Presets:  Standard

Print Settings

Page Setup: Standard
Paper Source: | Front Tray

(

Media Type: plain papers
Color:  Color

Mode: E Automatic Qualinr —_— Speed
) Advanced

o

Print Quality: Norma

i 1"r":-\._;ll Spead
E 1 Mirror Image
!| Quiet Mode

(%) (POFw ) ( Preview ) ([ Cancel )| E-Print)

9. Make the settings that you want to use to print. See online help for details of Print Settings.

= See “Selecting the Correct Paper Type” on page 34.

After completing the steps above, print one test copy and examine the results before printing an
entire job.
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Poster Printing (for Windows only)

Poster printing allows you to print poster-size images by enlarging one page to cover several sheets
of paper.

Printer settings

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXXX Printing Preferences

| 2r Shorcuts [ B Main ) i@ Advanced | [1] Page Layout| . Maintenance
Cuality Qption
| Ll - P
= s [l
- B - G )
) Draft @ Tet (O Text&Image (OGraphic () Photo
Faper Dptions Frink Ophions
- R Order
Source |Fronk Tray @ E;:“
Type | plain papers [ rayscals
Size :mz'lnxzq?m @ [ st Mode
2-sided printing
@ off
) Auto
Ink Levels Orlentakion
_H -I (%) Poatrait
] ) Landscape
[] Shew this sereen First
| ResstDefauks | | Technical Suppart |
C_ox_J|[ come |

2. Click the Main tab, then select one of the following Quality Option settings:

Text for text-only documents

Graphic for higher quality graphics

(I T SR

Photo for good quality and speed

3. Select the paper source as the Source setting.
4. Select the appropriate Type setting.

= See “Selecting the Correct Paper Type” on

Draft for rough drafts with reduced print quality

Text & Image for higher quality pages with text and images

page 34.
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Select the appropriate Size setting.
Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Click the Page Layout tab and select Multi-Page, then select Poster Printing. Click the up
or down arrow to select 2x1, 2x2, 3x3, or 4x4.

& EPSON J0000X Printing Preferences

[Zr Shotcts | &80 Main| 18 Advanced] (0] Pags Layout | 7 Maintenance|

Layout Z-sided prinking
[ reechace fEnlarge Document Off Margns. .
By Cukput Paper Size Auto
" ' Folded Booklet
Copies
[EMi-Pﬂu ] Copies | 1 =
Do o™ PR
[ @ rosterprinting ] [CJcolate
|.2_;f? @ More Options
Crotate 150°
e o
Watermark:
Mme Lo

[E

[ ok J[ coca |
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8. Click Settings to adjust the way your poster will be printed. The Poster Settings window opens.

Poster Settings

Please select the panels
that wou don't wish to be
printed. (The panels which
appear grayed ouk will nok
be printed)

[CPrint Cutking Guides

ik Marks

Zancel ] l Help
9. Make the following settings:
Print Cutting Prints guide lines for cutting.
Guides
Overlapping Slightly overlaps the panels and prints alignment markers so that the panels can
Alignment be aligned more precisely.
Marks
Trim Lines Prints border lines on the panels to guide you when trimming the pages.
Note:

If you want to print only a few of the panels without printing the entire poster, click the panels
that you do not want to print.

10. Click OK to close the Poster Settings window.
After completing the steps above, print one test copy and examine the results before printing an

entire job. Then follow the instructions.
= See “How to make a poster from your printouts” on page 113.
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How to make a poster from your printouts

Here is an example of how to make a poster with 2x2 selected under Poster Printing and
Overlapping Alignment Marks selected as the Print Cutting Guides.

Sheet 1 Sheet 2

Sheet 3 Sheet 4

1. Cut off the margin of Sheet 1 along a vertical line through the center of the top and bottom
cross marks:

X
™| | 0 [
Sheet 1 ! Sheet2 | mmsp | Sheet 1 Sheet 2
| | o |

2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the
two sheets together from the back:

4

Sheet 1 | Sheet 2

X
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3. Cut the taped sheets in two along a vertical line through the alignment markers (this time, a

line to the left of the cross marks):

X

i

B34

Sheet1§ Sheet 2 _}

0

Sheet 1

Sheet 2

4. Align the edges of the paper using the alignment markers and tape them together from the back:

Sheet 1

Sheet 2

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 together.

6. Repeat the instructions from step 1 to step 4 to tape the top and bottom edges of the paper:

Sheet 1

Sheet 2

L

Sheet 3

Sheet 4

7. Cut off the remaining margins.
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Watermark Printing (for Windows only)

Watermark printing allows you to print a text-based or image-based watermark on your document.

Printing the watermark

1. Access the printer settings.
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= See “Accessing the printer driver for Windows” on page 16.

& EPSON XXXXX Printing Preferences

[ Zr Shoncuts [ Main | @5 Advanced | (1] Page Layout | .~ Maintenanes|
Cuality Qption
4 o A
= s [l
= B i 2
) Draft @ Tet (O Text&Image (OGraphic () Photo
Paper Options Print OpLions
- Reverse Order
Source anl:_Trar @ %Prht
Type | plain papers [l Grayscale
Size | A4 210 % 297 mm E) [ st Mode
2-sided printing
(&) cff
DMU
Ink Levels Crienkakion
_u -I (%) Poatrait
) Landscape
[] Shew this sereen First
| ResstDefauks | | Technical Suppart |
o) coe |

Click the Main tab, then select one of the following Quality Option settings:

(d Draft for rough drafts with reduced print quality
(d Text for text-only documents with higher text quality
J Text & Image for higher quality documents with text

Select the paper source as the Source setting.
Select the appropriate Type setting.
= See “Selecting the Correct Paper Type” on page 34.

Select the appropriate Size setting.

and images

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Printing with Special Layout Options 116



B-310N/B-510DN  User’s Guide

7. Click the Page Layout tab, choose the desired watermark from the Watermark list, then click

Settings.

If you want to create your own watermark, see the following instructions.

& EPSON XXXKX Printing Preferences

Layout
[ reducafEnlargs Document

By Oubput Paper Size

] mhdti-Page
pﬂ__;.'.:_ Dt Sheat

Poster Printing

Watermark

Confidential

ByPercertaoe [ 3] %

| L7 Shonteuts | G Main| 2 mml_[ﬁ.l Page Layout | # Mairtenance |

Z-sided prinking
Lol Margins. ..
i futo
Macusal Folded Bookdat
Sdjusk Prink Densty, .

Copiaz
Copies | 1 >
[#]Reverse Order

lcotas (H

Mare Cokions
[Cretate 150°
[ mtrvee Image

Eeal

= See “Creating your own watermark” on page 118.
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8. Specify the settings you want for the watermark. You can change the position and size of the
watermark by dragging the image within the preview window.

‘Wakermark. I:Z-:-ﬂFi-:IEentiaI
Color |.Red V|
Poasition | E Center V|
Light Dark.
Density : 37
: o +
Size : J
[ QK l [ Cancel l [ Help l

9. Click OK to return to the Page Layout window.
10. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before printing an
entire job.

Creating your own watermark

You can add your own text-based or image-based watermarks to the Watermark list.

Printing with Special Layout Options 118



B-310N/B-510DN  User’s Guide

1. Click Add/Del under Watermark on the Page Layout window. The following window appears.

User Defined Watermarks

List : () Text () BMP

Marne : | |

Texk : | |

QK [ Cancel ] [ Help ]

2. Do one of the following:

(d To use an image file as a watermark, select BMP. Click Browse to locate the bitmap file
you want to use, then click Open. Type a name for your watermark in the Name text box,
then click Save.

(d To create a text-based watermark, select Text. Type your text in the Text box. This text will
also be used as the watermark name. If you want to change the watermark name, type a
new name in the Name text box, then click Save.

3. Click OK to return to the Page Layout window.
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4. Click Settings. The following window appears:

Watermark. EF"E-IZIZII"-I
Text |EPSON |
Color | B Fed v|
Fant Setting
Fonk |P.ria| V|
Biold
Style Ttalic
Underline
Circle
Fasition | [=] enter v| fquare
Light Dark.
Density Ii
P Raotation
- +
i e
c) Raotate with Mouse
[ Qi ] [ Cancel l [ Help l

Make sure that the appropriate watermark is selected in the Watermark list, then select Color,

Position, Density, Size, Font, Style, and Angle settings. (For details, see the online help.) Your

settings are reflected in the preview window.

When you finish making settings, click OK.
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Chapter 5
Using the Control Panel

Introduction

You can use the printer’s control panel to access a variety of menus that allow you to check the

status of consumable products, print status sheets, and make printer settings. This section
describes how to use the control panel.

The control panel of the printer consists of 7 buttons, 3 lights, and a liquid crystal display (LCD).

igl ] \\
¢ D

Buttons and lights

The table below describes the functions of the buttons on the control panel.
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Button

Description

O

Power button

Turns the printer on or off.

-

111

Cancel button

Cancels the print job if pressed during printing.

Returns to the Ready status when pressed in Menu mode.

<

Left button

Returns to the previous level when pressed in Menu mode.

A

Up button

Changes the parameter in the reverse order when selecting a desired parameter in
Menu mode.

v

Down button

Changes the parameters in forward order when selecting a desired parameter in Menu
mode.

>

Enters Menu mode when pressed in the Ready status.

Selects a desired menu when pressed in Menu mode.

Right button
O I( Sets the selected parameter in the selected item in Menu mode.
Executes the item if the selected item is for execution only.
OK button

Feeds the paper when paper feed failed.

The table below describes the meanings of the lights on the control panel. The lights let you know
the status of the printer and the type of an error when it occurs.
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Light

Description

O

Ink status light (orange)

On:

The installed ink cartridge is expended.

The ink cartridge is not installed.

The installed ink cartridges cannot be used with the printer.
The cartridge lock lever is in the unlocked position.

The installed maintenance box is at the end of its service life.
The maintenance box is not installed.

The installed maintenance box cannot be used with the printer.
The maintenance box cover is open.

Flashing:
The installed ink cartridge is nearly expended.
The maintenance box is nearing the end of its service life.

U

Paper status light (orange)

On:
No paper is loaded in the paper source.
The printer loads more than one sheet of paper at a time.

Flashing:
Paper is jammed.

Power light (green)

On:
The printer is in the Ready status.

Flashing:

The printer is starting.

The printer is printing.

The printer is cleaning the print head.
The printer is charging the ink.

The printer is canceling printing.

Off:
The printer is off.

Icons on the LCD

This section describes the meaning of icons displayed on the LCD screen.

The table below describes the meaning of ink cartridge status icon.

Icon

Description

The icon gives a rough estimate of the usable ink remaining in the ink

BREEE00 -
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Icon Description
u The installed ink cartridge is nearly expended.
E The installed ink cartridge is expended.
E The ink cartridge is not installed.
The installed ink cartridges cannot be used with the printer.

The table below describes the meaning of maintenance box status icon.

Icon Description
The icon gives a rough estimate of the remaining capacity of the
maintenance box.
u The installed maintenance box is nearing the end of its service life.
E The installed maintenance box is at the end of its service life.
E The maintenance box is not installed.
The installed maintenance box cannot be used with the printer.

How to access the control panel menus

This section describes how to enter Menu mode and make settings with the buttons on the control
panel.

Note:
Press the W Cancel button whenever you want to exit Menu mode and return to the Ready status.

[ Press the 4 Left button to return to the previous step.

1. Make sure that READY appears on the LCD screen, and then press the » Right button. The
first menu appears on the LCD screen.
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If ENTER PASSWORD appears on the LCD panel, enter the password. See “Entering the
password” on page 133.

2. Press the ¥ Down or A Up button to scroll through the menus.

3. Press the OK or P Right button to select the desired menu. The first item appears on the LCD
screen.

4. Press the ¥ Down or A Up button to scroll through the items.

5. Press the OK or » Right button to select the desired item. The first parameter appears on the
LCD screen.

6. Press the ¥ Down or A Up button to scroll through the parameters.

7. Press the OK button to store the selected parameter. If the parameter is for execution only,
press the OK button to execute the function for the item.

After execution, the printer returns to the previous menu.

8. Press the W Cancel button. The printer returns to the Ready status.

Control panel menu list

This section describes the parameter for each item in the menu.

Printer setting menu

This menu allows you to configure the basic printer setting.

Item Parameter
Language English, French, Italian, German, Spanish, Portuguese, Dutch, Japanese
USB Auto, ESC/P, PCL3
Network Auto, ESC/P, PCL3
Language
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You can select the language displayed on the LCD screen.
USB, Network

You can select the printer control language for the port.

Test print menu

This menu allows you to make settings related to test print.

Item Parameter

Nozzle check -

Status sheet -

Network sheet -

Nozzle check

You can print a print head nozzle check pattern for each ink cartridge. From the printing results,
you can check whether the nozzles are delivering ink properly.

= See “Checking the Print Head Nozzles” on page 151.
Status sheet

You can print the current printer status.

= See “Printing the status sheet” on page 132.
Network sheet

You can print the current settings of the network interface.

Printer status menu

This menu allows you to check the current printer status.
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Item

Parameter

Version

Sh XXXX, XXXXX

Maintenance box

xx%

Version

You can check the firmware version.

Maintenance box

You can get a rough estimate of the remaining capacity of the maintenance box.

Maintenance menu

This menu allows you to make settings related to maintenance.

Item Parameter
Head alignment -

Cleaning -

Cleaning sheet -

Contrast ad;]. -10-10
Auto cleaning On, Off
Low speed mode On, Off

Head alignment

You can print a head alignment test pattern. From the printing results, you can adjust the head

alignment.

Cleaning

You can clean the print head. You can also print nozzle check pattern before cleaning.

Cleaning sheet

You can clean up the rollers inside the printer.
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Contrast adj.
You can adjust the contrast of the LCD screen. Press the A Up or ¥ Down button to adjust contrast.

Auto Cleaning

This printer automatically checks the print head nozzles without printing a pattern and cleans the
nozzles if they are clogged. Some ink is consumed from all cartridges while checking the print head

nozzles.

You can choose to turn this function Off or On.

Low Speed Mode

This function may prevent the print head nozzles from becoming clogged.

You can choose to turn this function Off or On.

Network setting menu

This menu allows you to make network settings.

Item Parameter
Network setup Auto -
Panel IP address 000.000.000.000-255.255.255.255
Subnet mask 000.000.000.000-255.255.255.255
Default gateway 000.000.000.000-255.255.255.255
Bonjour On, Off
Init N/W set -
Network setup

You can select the method to configure the network settings.

When Auto is selected, the printer obtains the IP address, Subnet mask and Default gateway
automatically. When Panel is selected, you can specify the IP address, Subnet mask, Default
gateway and Bonjour settings using the control panel. When Init N/W set is selected, you can
revert the network settings of the printer to the factory default value.
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IP address, Subnet mask, Default gateway

You can set the IP address, Subnet Mask, and Default Gateway to the printer. To change the
parameter, press the € Left or » Right button to move cursor and the A Up or ¥ Down button to
change number.

Bonjour

You can set the Bonjour settings of the printer.

Password menu

This menu allows you to make settings related to the LCD panel lock.

Item Parameter

Password setting -

Lock setting Off, On

Password setting

You can set the password for the LCD panel lock by entering the current password once and the
new password twice. To enter the password, see “Entering the password” on page 133.

Note:
A The password is set to

«»

(none) as the factory default.

[ The password must be 1 to 8 characters.

1 Alphanumeric characters are available for the password.
d If you forget the password, contact Epson Support.

= See “Contacting Epson Support” on page 190.
Lock setting

You can lock the LCD panel to make it childproof, or to prevent unexpected changes made by
using the LCD panel.

When Ready appears on the LCD screen after you set this function On, you need to enter the
password when you press the » Right button to enter the Menu mode.
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Status and error messages

This section describes the meaning of messages displayed on the LCD screen.

The table below describes the status messages.

Message Description
Cancel The print job is canceled.
Charging ink The printer is charging the ink.
Cleaning The printer is cleaning the print head.
Please wait The printer is starting.

The printer is initializing the settings.
Printing The printer is processing data.
Ready The printer is ready to print.
Power save The printer is in the power save mode.
Power off The printer is shutting down.
Reset The printer is resetting the settings.

The table below contains error messages, a brief description of each message and suggestions for

correcting the problem.

Message

Problem

Solutions

Service call see guide

Service call error occurs.

Turn off the printer and then back on. If
the error does not clear, contact Epson
Service Center.

= See “Contacting Epson Support” on
page 190.

Printer near end of service
life

Parts inside the printer are at the end of
their service life.

Contact Epson Service Center to replace
them.

= See “Contacting Epson Support” on
page 190.
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Message

Problem

Solutions

Nozzle maint error see
guide

Print head nozzles are clogged or
misaligned.

Perform the nozzle check and print head
cleaning.

= See “Checking the Print Head Nozzles”
on page 151.

= See “Cleaning the Print Head” on page
153.

Press the OK button to recover from
error status.

Printer error restart printer

Printer error occurs.

Note the error code and turn off the
printer.

If the error code is 0x01, 0x03, 0x04, 0x05,
0x08, or 0x0A, make sure no paper is
jammed in the printer.

= See “The Paper Jams” on page 172.
Then turn back on the printer.

If the error does not clear again, turn off
the printer again and contact Epson
Service Center.

= See “Contacting Epson Support” on
page 190.

Close maint box cover

The maintenance box cover is open.

Close the maintenance box cover.

Set maint box

The maintenance box is not installed.

Install the maintenance box.

The maintenance box is not correctly
recognized by the printer.

Reinstall the maintenance box or replace
it.

Replace maint box

The maintenance box is at the end of its
service life.

Replace the maintenance box.

= See “Replacing a maintenance box” on
page 149.

Move ink lever down

The cartridge lever is in the unlocked
position.

Move the cartridge lever to the locked
position.

Set ink cartridge

The ink cartridge is not installed.

Install the ink cartridge.

Set ink then move ink
lever down

The ink cartridge is not installed.

Install the ink cartridge and move the
cartridge lever to the locked position.
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Message

Problem

Solutions

Replace ink cartridge

The ink cartridge cannot be used with

Install the genuine ink cartridge.

the printer.

The ink cartridge is expended. Replace the ink cartridge.

= See “Replacing an ink cartridge” on
page 142.

Paper is not loaded in the front paper
cassette.

Set paper in cassette Load the paper in the front paper cassette.

Set paper in auto feeder Paper is not loaded in the rear sheet Load the paper in the rear sheet feeder.

feeder.

Remove jammed paper Paper is jammed in front paper cassette Remove the jammed paper.

or rear sheet feeder.
= See “The Paper Jams” on page 172.

The printer feeds more than one sheet of
paper at a time.

Remove the jammed paper, and then
press the OK button.

Double feed jam remove
paper

Close printer cover The printer cover is open during printing. | Close the printer cover.

Set duplex unit The duplex unit is removed. Attach the duplex unit.

Duplex unit jam remove Remove the jammed paper.

paper

Paper is jammed in duplex unit.

= See “The Paper Jams” on page 172.

Printing the status sheet

While in Menu mode, you can print a status sheet to see the current default values. To print a
status sheet, follow the steps below.

1. Make sure that A4 size paper is loaded in the front paper cassette.
2. Press the » Right button to enter Menu mode.

3. Press the ¥ Down or A Up button to display TEST PRINT, and then press the OK or » Right
button.

4. Press the ¥ Down or A Up button to display STATUS SHEET, and then press the OK or
» Right button.

5. Press the OK button to start printing a status sheet.
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After printing is finished, the printer returns to the Test print menu.

Entering the password

When you want to set or change the password from Password menu, or press the » Right button
to enter Menu mode after the LCD panel is locked, you need to enter the password.

Follow the instructions below to enter the password.

Note:
If the current password is the factory default, just press the OK button to proceed.

1. Press the ¥ Down or A Up button to display the character you want to select.
2. Press the » Right button to determine the character.
3. Repeat steps 1 and 2.

4. Once all characters are set, press the OK button.
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Chapter 6
Installing Option

Duplex Unit (B-310N only)

Installing the duplex unit
Follow the steps below to install the duplex unit.
1. Turn off the printer

2. Press the hooks on both sides of the upper rear printer cover, and then remove the upper rear
printer cover.

Note:
The removed upper rear printer cover should be retained since it will be necessary when you
remove the duplex unit.
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3. Insert the bottom side of the duplex unit first, and then attach the duplex unit.

Uninstalling the duplex unit

Follow the steps below to uninstall the duplex unit.
1. Turn off the printer.

2. Remove the duplex unit by pulling it while holding down the buttons on both sides of the
duplex unit.
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3. Attach the upper rear printer cover.
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Chapter7
Replacing Consumables

Ink Cartridges

Checking the ink cartridge status

Using the control panel

To check the ink cartridge status, see “Icons on the LCD” on page 123.

For Windows

Note:
Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink cartridges
are installed, the ink cartridge status will not be displayed.

To check the ink cartridge status, do one of the following:

(d Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon to the
taskbar, refer to the following section.
= See “From the shortcut icon on the taskbar” on page 17.

(d Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3
button.

& EPSON XXXXX Printing Preferences

| 5 Main | &% Advanced | ) Page Layout|| @ Maintenance ||

r" . Status Monitor 3 (M)
l] IJse this ukility to autoratically check Far errors and also check

the level of ink remaining,

[ﬁ Mozzle Check (1)
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A graphic displays the ink cartridge status.

B EPSOM Status Monitor 3 @ EPSON XXXXX

EPSON "o

[ Raady to prirt.

| Technical Suppert |

Ink Levels

ﬁﬁ
o K XM

[Maintenance Box Service Life

o
—E—

Note:
If any of the ink cartridges installed in the printer is broken, incompatible with the printer model,
or improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of the

ink cartridge status. Be sure to replace or reinstall any ink cartridge indicated by EPSON Status
Monitor 3.

The progress meter appears automatically when you start a print job. Click the Check Ink
Levels button, and then you can check the ink cartridge status from this window.
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Note:

To display the progress meter automatically, click the Maintenance tab in the printer driver
window, click Speed & Progress, and then select the Show Progress Meter check box.

B EpSON XXNEK

EPSON 1yt wors-sona

LISB001

| Media Type : plain papers
Paper Size : A4 210 x 297 mm

[ checkinkieves | |
CTes  J[_Pase ][ ]

.F-url;u-at resuks, make sure you use genuine Epsan ink
cartridges.

- [ om ]

B EPSON XXXX¥ - USBOOM

EPSON 'y wors-scm

Media Type : plain papers
Paper Size 1 A4 210 = 297 mm

-memsﬁ,mglemmwnmmik ‘

| Hide Ink Levels | Technical Support |
Ink Levels
L Tes  J[ pase J[ 50 |
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For Mac OS X

You can check the ink cartridge status using EPSON StatusMonitor. Follow the steps below.
1. Access the EPSON Printer Utility3 dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.
2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

[ NN EPSON StatusMonitor

EPSON M‘ EFSON 20000
oY

EFSON StatusMonitor
Remaining Ink besrel

Click the image of the ink cartridge to display information
about the current cartridge.

Maintenance Box Service Life

%ijrm

( update ) (0K

Note:
(d  The graphic displays the ink cartridge status when EPSON StatusMonitor was first opened. To
update the ink cartridge status, click Update.

1 Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink
cartridges are installed, the ink cartridge status may not be displayed.
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a

If any of the ink cartridges installed in the printer is broken, incompatible with the printer model,
or improperly installed, EPSON StatusMonitor will not display an accurate status of the ink
cartridge. Be sure to replace or reinstall any ink cartridge indicated by the EPSON StatusMonitor.

Note for Mac OS X 10.5:
The printer monitor window appears automatically when you start a print job. You can check the
ink cartridge status from this window.

Handling precautions

Read all of the instructions in this section before replacing the ink cartridges.

a

a

This printer uses ink cartridges equipped with an IC chip that monitors the amount of ink
used by each cartridge. Cartridges are usable even if they are removed and reinserted.

If you need to remove an ink cartridge temporarily, be sure to protect the ink supply area from
dirt and dust. Store the ink cartridge in the same environment as the printer. When storing the
cartridge, be sure that its label identifying the color of the ink cartridge is facing upward. Do
not store ink cartridges upside down.

The valve in the ink supply port is designed to contain any excess ink that may be released.
However, careful handling is recommended. Do not touch the supply port of the ink cartridge
or its surrounding area.

Some ink is consumed from all cartridges during the following operations: print head cleaning,
initial ink charging, and nozzle maintaining.

Never turn off the printer during initial ink charging. The ink may fail to be filled up and the
printer may become unavailable to print.

If you change the ink cartridge to Extra High Capacity Ink Cartridge, retain the default ink
cartridge or Standard Capacity Ink Cartridge, or High Capacity Ink Cartridge. One of these
cartridges is needed when you transport the printer.

Other products not manufactured by Epson may cause damage that is not covered by Epson’s
warranties, and under certain circumstances, may cause erratic printer behavior.

Keep ink cartridges out of the reach of children. Do not allow children to drink the ink or
handle the cartridges.

Be careful when you handle used ink cartridges, as there may be some ink around the ink
supply port or surrounding area. If ink gets on your skin, wash the area thoroughly with soap
and water. If ink gets into your eyes, flush them immediately with water. If discomfort or
vision problems continue after a thorough flushing, see a doctor immediately.
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Epson recommends the use of genuine Epson ink cartridges. The use of non-genuine ink may
cause damage that is not covered by Epson’s warranties, and under certain circumstances, may
cause erratic printer behavior. Epson cannot guarantee the quality or reliability of non-genuine
ink. The ink cartridge status is not displayed when non-genuine ink is used.

Leave the old cartridge installed in the printer until you have obtained a replacement;
otherwise, ink remaining in the print head nozzles may dry out.

You cannot continue printing with one ink cartridge expended, even if the other cartridges still
contain ink. Before printing, replace the expended cartridge.

Never turn off the printer while replacing the ink cartridge. Doing so may damage the IC chip
on the ink cartridge and the printer may not print properly.

To ensure you receive premium print quality and to help protect your print head, a variable
ink safety reserve remains in the cartridge when your printer indicates to replace the cartridge.
The yields quoted for you do not include this reserve.

Replacing an ink cartridge

To replace the ink cartridge, follow the steps below.

1.

Open the cartridge cover.
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3. Remove the expended installed ink cartridge.

Note:
Hold the printer with your hand when you remove the ink cartridge.

4. Remove the new ink cartridge from the package.
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Caution:
g A Do not touch the green IC chip on the side of the cartridge. This can damage the ink
cartridge.

d  Always install an ink cartridge immediately after removing the old cartridge. If the
cartridge is not installed promptly, the print head may dry out and be unable to print.

5. For best results, shake the ink cartridge for about five seconds.

0:00'05"
(&)

5

6. Hold the ink cartridge with the arrow mark facing up and pointing to the rear of the printer,
and then insert it into the slot.
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Note:
Hold the printer with your hand when you install the ink cartridge.

g Caution:
Do not remove and reinsert cartridges more often than necessary. Doing so can
compromise the needle valve seal and allow air to enter the ink tubes, causing nozzle loss.

7. Move the cartridge lever to the locked position.

8. Close the cartridge cover.

Note:
When you install the Extra High Capacity Ink Cartridge, use the printer with the cartridge cover
opened.
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Maintenance Box

Checking the maintenance box status

Using the control panel

To check the maintenance box status using the control panel, follow the steps below.

1. Make sure that READY appears on the LCD screen, and then press the » Right button. Menu
appears on the LCD screen.

2. Press the ¥ Down or A Up button to select PRINTER STATUS, and then press the OK or
» Right button.

3. Press the ¥ Down or A Up button to select MAINTENANCE BOX, and then press the OK or
» Right button.

4. A rough estimate of the remaining capacity of the maintenance box appears on the LCD screen.
Note:

You can check the maintenance box status by the icon displayed on the lower right of the LCD screen
as well.

= See “Icons on the LCD” on page 123.

For Windows

Note:
Epson cannot guarantee the quality or reliability of non-genuine maintenance box.

To check the maintenance box status, do one of the following:
(d Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon to the

taskbar, refer to the following section.
= See “From the shortcut icon on the taskbar” on page 17.
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(d Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3

button.

& EPSON XXXXX Printing Preferences

| & Main [ &4 Advanced | &b Page La_l,JDut|| &6 Mantenance "

"‘" : Status Manitor 3 (M)

L]
(R

IJse this utility to aukomatically check for errors and also check
the level of ink remaining.

Mozzle Check (M)

A graphic displays the maintenance box status.

Note:

B EPSON Status Monitor 3 @ EPSON XXXXX

EPSON "%

| Ready to print.

Ink Levels

ﬁ
Lo S ¢ 4 4 4 ¢4 4 4

[Maintenance Box Service Life

.
=

If the maintenance box installed in the printer is broken, incompatible with the printer model, or
improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of the

maintenance box status. Be sure to replace or reinstall any ink cartridge indicated by EPSON
Status Monitor 3.
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For Mac OS X

You can check the maintenance box status using EPSON StatusMonitor. Follow the steps below.
1. Access the EPSON Printer Utility3 dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.
2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

[ NN EPSON StatusMonitor

EPSON Nf EPSON XXXHX

EFSON StatusMonitor
Remaining Ink besrel

Click the image of the ink cartridge to display information
about the current cartridge.

Maintenance Box Service Life

%ﬁj?m

(" Update | 0K

Note:
1 The graphic displays the maintenance box status when EPSON StatusMonitor was first opened.
To update the maintenance box status, click Update.

[ Epson cannot guarantee the quality or reliability of non-genuine maintenance box.

[ If the maintenance box installed in the printer is broken, incompatible with the printer model, or
improperly installed, EPSON StatusMonitor will not display an accurate status of the
maintenance box. Be sure to replace or reinstall the maintenance box.
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Handling precautions
Read all of the instructions in this section before replacing the maintenance box.

(d Epson recommends the use of genuine Epson maintenance box. The use of non-genuine
maintenance box may cause damage that is not covered by Epson’s warranties, and under
certain circumstances, may cause erratic printer behavior. Epson cannot guarantee the quality
of reliability of non-genuine maintenance box.

Do not dismantle the maintenance box.

Do not touch the green IC chip on the side of the maintenance box.
Keep out of reach of children, and do not drink the ink.

Do not peel off the film covering the maintenance box.

Do not tilt the used maintenance box until it is placed in the plastic bag provided.

U0 J d od o

Do not reuse a maintenance box which has been removed and left detached for a long period.

Replacing a maintenance box

To replace the maintenance box, follow the steps below.
1. Confirm that the printer is not draining the ink.

2. Open the maintenance box cover.

3. Remove the new maintenance box from the package.

4. Lift up and pull the installed maintenance box outward.

Replacing Consumables 149



B-310N/B-510DN  User’s Guide

Note:
Do not tilt the maintenance box when you uninstall the maintenance box.

1 Hold the maintenance box with both hands when you handle the maintenance box.

=7

5. Put the used maintenance box into the plastic bag, and then seal off.

Note:
The plastic bag is provided with the new maintenance box.

6.

7. Close the maintenance box cover.

Replacing Consumables 150



B-310N/B-510DN  User’s Guide

Chapter 8
Maintaining Your Printer

Auto Head Maintenance

This printer automatically checks the print head nozzles without printing a pattern and cleans the
nozzles if they are clogged (Auto Head Maintenance). You can choose to turn this function on or
off from the printer’s control panel.

Automatic nozzle checking is performed at predefined times.

Note:
[ Depending on the circumstances, Auto Head Maintenance may not completely clean the print
head nozzles.

[ Some ink is consumed from all cartridges while checking the print head nozzles and cleaning the
print head.

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to
identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or
from the printer by using the control panel or buttons.

Note:

This printer checks the print head on a regular basis to keep the print head clean and to ensure you
receive premium print quality. If the print head nozzles are clogged, the printer automatically cleans
the print head. Normally, you do not need to perform the nozzle check and print head cleaning,
however, the self-cleaning function cannot completely prevent the occurrence of missing dots.

Using the Nozzle Check utility for Windows

Follow the steps below to use the Nozzle Check utility.

1. Make sure that no lights are indicating errors.
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Make sure that A4 size paper is loaded in the front paper cassette.

Right-click the printer icon on the taskbar, then select Nozzle Check.

If the printer icon does not appear, refer to the following section to add the icon.
= See “From the shortcut icon on the taskbar” on page 17.

Follow the on-screen instructions.

Using the Nozzle Check utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

1.

2.

Make sure that no lights are indicating errors.

Make sure that A4 size paper is loaded in the sheet feeder.
Access the EPSON Printer Utility3 dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.
Click the Nozzle Check button in the Utility dialog.

Follow the on-screen instructions.

Using the control panel

Follow the steps below to check the print head nozzles using the control panel.

1.

Make sure that A4 size paper is loaded in the front paper cassette.

Make sure that READY or POWEAR SAVE appears on the LCD screen, and then press the

» Right button. Menu appears on the LCD screen.

Press the W Down or A Up button to select TEST PRINT, and then press the OK or » Right button.

Press the ¥ Down or A Up button to select NOZZLE CHECK, and then press the OK or » Right

button.
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5. Press the OK button to print nozzle check pattern.

After printing, the cleaning menu appears. If you find a print quality problem, press the OK
button to clean the print head.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no
print quality problems, such as gaps or missing segments in the test lines, the print head is fine.

: —

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink

nozzle or a misaligned print head.

il

| ]

\"H”\"’
|
" \’ \‘ \’ " \‘ " \’ \‘

= See “Cleaning the Print Head” on page 153.
= See “Aligning the Print Head” on page 156.

Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve
these problems by cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer
driver or from the printer by using the control panel or buttons.

Note:

d Because print head cleaning uses ink from all cartridges, clean the print head only if print quality
declines; for example, if the printout is blurry, the color is incorrect or missing, or the vertical
lines are pronouncedly misaligned.

(A Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves ink.
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a

When ink is low you may not be able to clean the print head. When ink is expended you cannot
clean the print head. Replace the appropriate ink cartridge first.
= See “Replacing an ink cartridge” on page 142.

Using the Head Cleaning utility for Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

1.

5.

Make sure the printer is turned on.

Make sure that no lights are indicating errors.

Make sure that A4 size paper is loaded in the front paper cassette.

Right-click the printer icon on the taskbar, then select Head Cleaning.

If the printer icon does not appear, refer to the following section to add the icon.
= See “From the shortcut icon on the taskbar” on page 17.

Follow the on-screen instructions.

The O Power light flashes while the printer performs the cleaning cycle.

Caution:
Never turn off the printer while the O Power light is flashing. Doing so may damage the printer.

Note:

a

a

4

If print quality has not improved after repeating this procedure, turn off the printer and wait for
at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary.

If print quality remains a problem, contact Epson Service Center.
= See “Contacting Epson Support” on page 190.

To maintain print quality, we recommend printing a few pages on a regular basis.

Using the Head Cleaning utility for Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.

1.

Make sure the printer is turned on.
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Make sure that no lights are indicating errors.

Make sure that A4 size paper is loaded in the sheet feeder.
Access the EPSON Printer Utility3.

= See “Accessing the printer driver for Mac OS X” on page 17.
Click the Head Cleaning button in the Utility dialog.

Follow the on-screen instructions.

The O power light flashes while the printer performs the cleaning cycle.

n Caution:

Never turn off the printer while the O power light is flashing. Doing so may damage the printer.

Note:

a

If print quality has not improved after repeating this procedure about four times, turn the printer
off and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning
if necessary. If print quality has still not improved, contact your dealer.

To maintain print quality, we recommend printing a few pages on a regular basis.

Using the control panel

Follow the steps below to clean the print head using the control panel.

1.

Make sure that A4 size paper is loaded in the front paper cassette.

Make sure that READY or POWEAR SAVE appears on the LCD screen, and then press the
» Right button. Menu appears on the LCD screen.

Press the ¥ Down or A Up button to select MAINTENANCE, and then press the OK or P Right
button.

Press the ¥ Down or A Up button to select CLEANING, and then press the OK or » Right button.

Press the OK button to start cleaning and the O Power light begins flashing.
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n Caution:
Never turn off the printer while the O Power light is flashing. Doing so may damage the
printer.

6. When the O Power light stops flashing, the printer returns to the nozzle check menu. Press the
OK button to print a nozzle check pattern to confirm that the head is clean.
= See “Checking the Print Head Nozzles” on page 151.

Note:
[ If print quality has not improved after repeating this procedure, turn off the printer and wait for
at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary.

[ If print quality remains a problem, contact Epson Service Center.
= See “Contacting Epson Support” on page 190.

A To maintain print quality, we recommend printing a few pages on a regular basis.

Aligning the Print Head
If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this
problem by using the Print Head Alignment utility in your printer driver or from the printer by

using the buttons.

Note:
If you notice a pronounced misalignment of vertical lines, be sure to clean the print head first.

= See “Cleaning the Print Head” on page 153.
Refer to the appropriate section below.
Note:

Do not press the T Cancel button to cancel printing while printing a test pattern with the Print Head
Alignment utility.

Using the Print Head Alignment utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no lights are indicating errors.
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Make sure A4 size plain paper is loaded in the front paper cassette.

Right-click the printer icon on the taskbar, then select Print Head Alignment.
If the printer icon does not appear, refer to the following section to add the icon.
= See “From the shortcut icon on the taskbar” on page 17.

Follow the on-screen instructions to align the print head.

Using the Print Head Alignment utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

1.

2.

Make sure that no lights are indicating errors.

Make sure A4 size paper is loaded in the sheet feeder.

Access the EPSON Printer Utility3 dialog.

= See “Accessing the printer driver for Mac OS X” on page 17.
Click the Print Head Alignment button in the Utility dialog.

Follow the on-screen instructions to align the print head.

Using the control panel

Follow the steps below to align the print head using the control panel.

1.

Make sure that A4 size plain paper is loaded in the front paper cassette.

Make sure that READY appears on the LCD screen, and then press the » Right button. Menu

appears on the LCD screen.

Press the ¥ Down or A Up button to select MAINTENANCE, and then press the OK or P Right

button.

Press the ¥ Down or A Up button to select HEAD ALIGNMENT, and then press the OK or

» Right button.
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5. Press the OK button to print the alignment pattern.

6. Look at the alignment patterns and find the square without any visible bands in sets #1
through #5.

7. Press the ¥ Down or A Up button to select the number that corresponds to the square for sets
#1 through #5.

8. Press the OK button to register your selection.

Cleaning Your Printer

To keep your printer operating at its best, clean it thoroughly several times a year.

Warning:

Be careful not to touch the parts inside the printer.

n Caution:

(A Never use alcohol or thinner to clean the printer. These chemicals can damage the printer.
Do not apply grease to the metal parts under the print head.
Be careful to keep water away from the electronic components.

Do not spray the inside of the printer with lubricants.

LCO Jd d

Unsuitable oils can damage the mechanism. Contact Epson Service Center or a qualified
service person if lubrication is needed.

Note:
After using the printer, close the paper support and the output tray to protect the printer from dust.

Cleaning Inside of Your Printer

Ink and paper build up from the rollers may affect the print quality or may prevent the paper from
feeding smoothly. You can clean the inside of your printer using the control panel.

Caution:
Do not use cloths to wipe inside the printer. Little pieces of thread may be built up.
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Using the control panel

Follow the steps below to align the print head using the control panel.

1.

Make sure that A4 size paper is loaded in the front paper cassette.

Make sure that READY appears on the LCD screen, and then press the » Right button. Menu
appears on the LCD screen.

Press the ¥ Down or A Up button to select MAINTENANCE, and then press the OK or P Right
button.

Press the ¥ Down or A Up button to select CLEANING SHEET, and then press the OK or
» Right button.

Press the OK button. The printer feeds and ejects paper.

Repeat these steps until no ink gets on the paper.

Transporting Your Printer

If you need to transport your printer some distance, carefully prepare and repack it as described
below. Use the original box and packing materials, or a similar box that holds the printer snugly.

Caution:

When storing or transporting the printer, do not tilt it, stand it up vertically, or turn it upside
down. Otherwise, ink may leak inside the printer.

Plug in the printer and turn it on. Wait until the print head returns to the home position.
Turn off the printer and unplug its power cord.

Caution:

Do not unplug the power cord during the print head is moving since the print head does
not return to the home position.

Disconnect the interface cable.

Remove all paper from the printer.
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5. Confirm that the cartridge lever is in the locked position and the cartridge cover is closed.

n Caution:
Leave the ink cartridges and maintenance box installed to prevent the ink from leaking.

Note:
If you use the Extra High Capacity Ink Cartridge, install the default ink cartridge or Standard
Capacity Ink Cartridge, or High Capacity Ink Cartridge instead when you transport the printer.

6. Close the output tray and paper support.
7. Attach the protective materials to both sides of the printer.
8. Repack the printer and power cord in the original box.

Note:
[ Keep the printer level during transport.

[ Be sure to remove the protective materials from the printer before using it again.

[ Do not hold the duplex unit when you lift the printer to prevent the duplex unit from becoming
detached. Also, make sure that the duplex unit is attached correctly after setting up the printer.

Maintaining Your Printer 160



B-310N/B-510DN  User’s Guide

Chapter 9
Using the Printer on a Network

Setting Up the Printer on a Network

This printer can connect anywhere on your network using 10Base-T or 100Base-TX because it has
a built-in Ethernet interface that supports the TCP/IP protocol.

You can make the network interface settings such as IP address by using the printer’s control
panel, or the applications for your computer.

Using the printer’s control panel

= See “Network setting menu” on page 128.
= See also “How to access the control panel menus” on page 124.

Using the utilities for your computer
= See the network guide in the CD-ROM.

Note:
[ To find the supported OS versions for the printer, see the following section.
= See “Operating System Versions” on page 10.

Be aware that NetWare is not supported.
Be aware that the protocols AppleTalk, NetBEUI, WSD, and LLTD are not supported.

To find the bundled utilities, see the CD-ROM shipped with your printer.

LU0 J O

To get more information, see the following section.
= See “Where To Get Help” on page 190.

Setting Up the Printer as the Shared Printer for Windows

These instructions tell you how to set up your printer so users on the network can share it.
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First you will set up the printer as a shared printer on the computer directly connected to it. This
computer is the print server. Then you will add the printer to each network computer that will
access it. Then each computer is the print server’s client.

Note:

a

a

These instructions are for small networks only. To share the printer on a large network, consult
your network administrator.

To uninstall programs in Windows 7, Vista and Server 2008, you need an administrator account
and the password if you log on as a standard user.

You must log on to a Computer Administrator account to install software on Windows XP and
Server 2003.

You must log on to Windows 2000 as a user with administrative privileges (belonging to the
Administrators group) to install software.

The illustrations in the following section are from Windows XP.

Setting up the print server

Follow the steps below on the print server computer that is connected directly to the printer:

1.

Windows 7:
Click the start button, select Devices and Printers.

Windows Vista and Server 2008:
Click the start button, select Control Panel, and then select Printer from the Hardware and
Sound category. (If the Control Panel is in Classic View, click Printers.)

Windows XP and Server 2003:

Click Start and select Control Panel, then double-click Printers and Faxes. (If the Control
Panel is in Category View, click Printers and Other Hardware, then click Printers and
Faxes.)

Windows 2000:
Click Start, point to Settings, and click Printers.

Windows 7:
Right-click the icon for your printer, click Printer properties, and then click Sharing tab.
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Windows Vista and Server 2008:
Right-click the icon for your printer, then click the Change sharing options button, and then
click Continue.

Windows XP, 2000 and Server 2003:
Right-click the icon for your printer, then click Sharing.

Windows 7, Vista, XP, Server 2008, Server 2003:
Select Share this printer, then type a Share name.

Windows 2000:
Select Shared as, then type a name for the shared printer.

Note:
Do not use spaces or hyphens in the share name.

& EPSON XXXXX Properties

Color Management | Security Yersion Information

General | Sharing i Forts Advanced

@ You can share this printer with other users on your network. To

Lo enable sharing for this printer, click Share this printer. |f pou share
thiz printer, Windows Firewall will be configured to allow this
prititer to be shared with other computers on the netwark.

() Do nat share this printer

(%) Share this printer

[ Share name:; |EF'SEIN |I

[ List i the directary

Diivers

If thiz printer iz shared with users running different versions of
Windowes, pou may want bo ingtall additional drivers, 2o that the
uszers do not have ta find the print driver when they connect ta

the zhared printer.
Additional Drivers. ..

] 4 [ Cancel H Apply l

If you want to setup a print server computer to allow client computers running different
versions of Windows to automatically download printer drivers from the print server, click
Additional Drivers and select the environment and the operating systems of the other
computers. Click OK, then insert the printer software CD into the CD-ROM drive.
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4. Click OK or Close (if you installed additional drivers).

Setting up each client

Follow these steps for each client computer on the network.

Note:
Your printer must be set up as a shared printer on the computer to which it is connected before you
can access it from another computer.

= See “Setting up the print server” on page 162.

1. Windows 7:
Click the start button, select Devices and Printers.

Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and
Sound category. (If the Control Panel is in Classic View, click Printers.)

Windows XP:

Click Start and select Control Panel, then double-click Printers and Faxes. (If the Control
Panel is in Category View, click Printers and Other Hardware, then click Printers and
Faxes.)

Windows 2000:
Click Start, point to Settings, and click Printers.

2. Windows 7 and Vista:
Click the Add a printer button.

Windows XP and 2000:
Double-click the Add Printer icon. The Add Printer Wizard appears. Click the Next button.

3. Windows 7 and Vista:
Click Add a network, wireless or Bluetooth printer, and then click Next.

Windows XP:
Select A network printer, or a printer attached to another computer, then click Next.
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Windows 2000:
Select Network printer, then click Next.

Add Printer Wizard

Local or Hetwork Printer
The wizard needs to know which type of printer to set up,

Select the option that describes the printer you want to uee:

() Local printer attached ta this compter

[ (%)i& netwark printer. or a printer attached to anather computer ]

& To zet up a network, printer that iz not attached to 3 print zerver,
\1‘) uze the "Local printer option.

P
[ < Back H MHeut » ][ Cancel

4. Follow the on-screen instructions to select the printer you want to use.

Note:

d Depending on the operating system and the configuration of the computer to which the printer is
connected, the Add Printer Wizard may prompt you to install the printer driver from the printer
software CD-ROM. Click the Have Disk button and follow the on-screen instructions.

[ To monitor the status of a shared printer, EPSON Status Monitor 3 must be installed on each
computer. EPSON Status Monitor 3 is automatically installed when you install the printer
software from the CD-ROM by using the Easy Install function.

Setting Up the Printer as the Shared Printer for Mac OS X

To set up your printer on a Mac OS X network, use the Printer Sharing setting. See your
Macintosh documentation for details.

Note:
When your printer is shared on a Mac OS X network, the EPSON Printer Utility3 icon does not
appear in the Print window.
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Chapter 10
Troubleshooting

Diagnosing the Problem

Troubleshooting printer problems is best handled in two steps: first diagnose the problem, then
apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by
online problem solving, the control panel, the status monitor utility, or by running a printer
operation check. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printout problem not related to print
quality, or a paper feeding problem, or if the printer does not print at all, refer to the appropriate

section.

To solve a problem, you may need to cancel printing.
= See “Canceling Printing” on page 58.

Error indicators
You can diagnose and solve most problems by checking the error messages on the LCD screen. If
the printer stops working and displays a message on the LCD screen, refer to the section below to

diagnose the problem, and then follow the recommended corrective measures.

= See “Status and error messages” on page 130.

Running a printer operation check

If you are unable to determine the source of the problem, run a printer operation check to help
you determine whether the problem comes from the printer or your computer.

To run a printer operation check, follow these steps.
1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the interface connector of the printer.
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8.

Make sure that A4 size paper is loaded in the front paper cassette.
Turn on the printer and make sure that READY appears on the LCD screen.
Press the » Right button to enter Menu mode.

Press the ¥ Down or A Up button to display TEST PRINT, and then press the OK or » Right
button.

Press the ¥ Down or A Up button to display NOZZLE CHECK, and then press the OK or
» Right button.

Press the OK button to start printing a nozzle check pattern.

A test page prints showing a nozzle check pattern. If the pattern has gaps, you need to clean the
print head.
= See “Cleaning the Print Head” on page 153.

a

If the test page prints, the problem probably lies in your software settings, the cable, or your
computer. It is also possible that your software may not be installed correctly. Try uninstalling
your software and reinstalling it.

= See “Uninstalling the Printer Software” on page 20.

If the test page does not print, you may have a problem with your printer. Try the suggestions
in the following section.
= See “The Printer Does Not Print” on page 185.

Checking Printer Status

For Windows

Note:
When you use your printer as a shared printer on a network with the following combinations of
computers, the client operating systems are not able to communicate with the printer, so that some

functions are not available for that particular client.

Server Client

Windows Vista/XP Windows 2000
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Server Client

Windows 2000

Windows Vista/XP

Using the progress meter

When you send a print job to the printer, the progress meter appears, as shown in the illustration

below.

B ERSOM OO0

LISE001

EPSON  occn vers-ssonee

Reenzining 0 sec
P_ags:ﬂ,l'l

Medis Type : plain papers
Paper Size : A4 210 = 297 mm

| Check Ink Levels ]
s 1| Pase |[ 0 |
.Fﬂrqaatmsm,mﬂnmmmwju&smﬂt
cartridges.

|y o)

The progress meter indicates the progress of the current print job and provides printer status
information. This window also displays error messages as well as helpful tips for better printing.

Refer to the appropriate section below.

Tips

Tips for getting the most out of your Epson printer driver appear in the text box of the progress
meter window. A new tip appears every 15 seconds. For more details on the tip displayed in the

window, click the Details button.

| Tips | [ Pause ] [ Stop ]

For great results, make sure wou use genuine Epsan ink
cartridges,

N
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Error messages

If a problem occurs during printing, an error message appears in the text box of the progress meter
window. For more detailed information, click Technical Support to access the online User’s Guide.

1B EpSOM Status Monitor 3 : EPSON X300

EPSON "o *m

'Seemmaudﬁnrrsh'ujirﬁmmmwiujumndpm.

| Technical Support

Ink Levels

ﬁ
oo XKoo MM

IMaintenance Box Service Life

Using EPSON Status Monitor 3
EPSON Status Monitor 3 displays detailed information on the printer status.
There are two ways to access EPSON Status Monitor 3:
(d Double-click the printer shortcut icon on the Windows taskbar. If the printer icon does not

appear, refer to the following section to add the icon.
= See “From the shortcut icon on the taskbar” on page 17.
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[ Open the printer driver, click the Maintenance tab, then click the Status Monitor 3 button.

& EPSON| XXX Printing Preferences

|(§ b ain | &4 Advanced | &b Page Layoutl'| &6 Mantenance "

"‘" : Status Manitor 3 (M)
" “ Use this utility to automatically check For errors and also check

the level of ink remaining.

[—H Mozzle Check (M)

When you access EPSON Status Monitor 3, the following window appears:

B EPSON Status Monitor 3 @ EPSON XXXXX

EPSON e

| Ready to print.

Ink Levels

iiﬁ
oK ol HEMHX

IMaintenance Box Servics Life

..
=

EPSON Status Monitor 3 provides the following information:

(d Ink Status:
EPSON Status Monitor 3 provides a graphic display of the ink status. To see the detailed
information on ink cartridge, click Information in the Ink Levels.
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(d Maintenance box Status:
EPSON Status Monitor 3 provides a graphic display of the maintenance box status.

(d Technical Support:
You can access the online User’s Guide from EPSON Status Monitor 3. If you encounter a
problem, click Technical Support in the EPSON Status Monitor 3 window.

For Mac OS X

Using EPSON StatusMonitor
If EPSON StatusMonitor detects a printer problem, it will inform you with an error message.
Follow these steps to access EPSON StatusMonitor.
1. Access the EPSON Printer Utility3.

= See “Accessing the printer driver for Mac OS X” on page 17.
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2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

[ - Nl Vil EPSON StatusMonitor

EPSON "’f ERSON 30000
3

EPSON StatusMonitor
:Remaining Ik lavel

Click the image of the ink cartridge to display information
about the current cartridge.

Maintenance Box Service Life

%rm

(update ) (oK)

The Paper Jams
n Caution:
Pull out the jammed paper gently. If you remove the jammed paper with force, torn pieces may
stay inside the printer or the printer may be damaged.
1. Press the OK button to eject the jammed paper.

2. Ifthe error does not clear, turn off the printer and remove all of the paper inside, including any
torn pieces. Refer to the appropriate section below.
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In the output tray:
Gently pull out the jammed paper forward.

Inside the printer:
Open the front printer cover, and then gently pull out the jammed paper forward.

g Caution:
Be careful not to touch the components indicated on the label inside the printer.

In the rear sheet feeder:
Gently pull out the jammed paper upward.
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In the front paper cassette:
Close the output tray and pull out the front paper cassette. Then gently pull out the jammed
paper forward.

Note:
[ If you cannot pull out the front paper cassette, pull out the output tray first and remove all
paper that is set in the front paper cassette.

Then pull out the front paper cassette and gently pull out the jammed paper forward.
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[ After you remove the jammed paper and insert the front paper cassette, reinsert the output
tray into the printer.

In the back of the printer:
Remove the duplex unit (B-510DN) or the upper rear printer cover (B-310N) and open the
lower rear printer cover. Then gently pull out the jammed paper.

B-510DN
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In the duplex unit:
Remove the duplex unit and open the cover of the duplex unit. Then, gently remove the
jammed paper.

3. Close the printer cover and turn on the printer.
4. Reload the paper and press the OK button to resume printing.

Note:

If you cannot easily remove a foreign object, do not use force and do not disassemble the printer.
Contact Epson Service Center for assistance.

= See “Contacting Epson Support” on page 190.

If your paper jams frequently, make sure of the following:

[ The paper is smooth, not curled or wrinkled.
d You are using high quality paper.

[ The printable side of the paper is face up in the rear sheet feeder and face down in the front
paper cassette.

(d The paper stack was fanned before loading.

[ The paper is not loaded above the = arrow mark inside the edge guide.
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(d The number of sheets in the paper stack does not exceed the limit specified for that paper.
= See “Loading capacities for Epson special media” on page 24.

(d The left edge guide is snug against the left edge of the paper.

(d The printer is on a flat, stable surface that extends beyond the base in all directions. The printer
will not operate properly if it is tilted.

Print Quality Problems

If you are having print quality problems, then compare it with the illustrations below. Click the
caption under the illustration that best resembles your printout.

cninalten alie

L Aufdruck. W
I 5008 "Regel

Good sample Good sample
cninaiien aiic TInalien alne
L Autdruck. Wy Aufdruck. W

o
)

I SN0 T Al l 500% HR ]l
JUVY INCECL CEC
“Horizontal banding” on page 178 “Vertical misalignment or banding” on

page 178

“Horizontal banding” on page 178 “Vertical misalignment or banding” on
page 178
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“Incorrect or missing colors” on page 179 “Blurry or smeared printout” on page 179
Horizontal banding
(d Make sure the printable side of the paper is face up in the rear sheet feeder and face down in

a

the front paper cassette.

Run the Head Cleaning utility to clear any clogged ink nozzles.
= See “Cleaning the Print Head” on page 153.

Use up ink cartridges within six months of opening vacuum package.
Try to use genuine Epson ink cartridges.

Check the ink cartridge status.
= See “Checking the ink cartridge status” on page 137.

If the graphic displays the ink is low or expended, replace the appropriate ink cartridge.
= See “Replacing an ink cartridge” on page 142.

Make sure the paper type selected in the printer driver is appropriate for the type of paper
loaded in the printer.
= See “Selecting the Correct Paper Type” on page 34.

Vertical misalignment or banding

a

a

a

Make sure the printable side of the paper is face up in the rear sheet feeder and face down in
the front paper cassette.

Run the Head Cleaning utility to clear any clogged ink nozzles.
= See “Cleaning the Print Head” on page 153.

Run the Print Head Alignment utility.
= See “Aligning the Print Head” on page 156.
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(A Clear the High Speed check box from the Advanced window in your printer driver
(Windows). See the printer driver online help for details.

(d Make sure the paper type selected in the printer driver is appropriate for the type of paper
loaded in the printer.
= See “Selecting the Correct Paper Type” on page 34.

Incorrect or missing colors

(d For Windows, clear the Grayscale setting in the Main or Advanced window in your printer
driver.

For Mac OS X, change the Color setting to Color in Print Settings dialog in the Print dialog of
your printer driver.

See the printer driver online help for details.

[ Adjust the color settings in your application or in your printer driver settings.

For Windows, confirm the settings in the Advanced window.
For Mac OS X, confirm the settings in the Print Settings dialog from the Print dialog.
See the printer driver online help for details.

(J Run the Head Cleaning utility.
= See “Cleaning the Print Head” on page 153.

(d Check the ink cartridge status.
= See “Checking the ink cartridge status” on page 137.

If the graphic displays the ink is low or expended, replace the appropriate ink cartridge.
= See “Replacing an ink cartridge” on page 142.

(d If your paper runs out, replace it as soon as possible. If the printer is left without paper for a
long period of time, the colors of your next print job may be incorrect.

Blurry or smeared printout

(d Use only paper recommended by Epson.
= See “Paper, Consumables, and Options” on page 203.
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(d Make sure the printer is on a flat, stable surface that extends beyond the base in all directions.
The printer will not operate properly if it is tilted.

(d Make sure your paper is not damaged, dirty, or too old.

(d Make sure your paper is dry and the printable side is facing up in the rear sheet feeder and
facing down in the front paper cassette.

[ Ifthepaperis curled toward the printable side, flatten it or curl it slightly in the opposite direction.

(d Make sure the paper type selected in the printer driver is appropriate for the type of paper
loaded in the printer.
= See “Selecting the Correct Paper Type” on page 34.

(d Remove each sheet from the output tray as it is printed.

(d If you are printing on glossy media, place a support sheet (or a sheet of plain paper) beneath
the stack, or load only one sheet at a time.

(d Do not touch or allow anything to come into contact with the printed side of paper with a
shiny finish. To handle your printouts, follow the instructions on the sheet packed with the paper.

[ Adjust the print density for the automatic 2-sided printing.
= See “2-Sided Printing” on page 61.

(4  (For Windows)
Adjust the print density for manual 2-sided printing or 1-sided printing. Access the printer
driver, click the Maintenance tab, click the Extended Settings button, and move the Print
Density slider to the left.

(d Run the Head Cleaning utility.
= See “Cleaning the Print Head” on page 153.

[ If the paper is smeared with ink after printing, clean the interior of the printer.
= See “Cleaning Inside of Your Printer” on page 158.

Miscellaneous Printout Problems

Incorrect or garbled characters

[ Turn off the printer and computer. Make sure the printer’s interface cable is securely plugged in.
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(d Uninstall the printer driver, then reinstall it.
= See “Uninstalling the Printer Software” on page 20.

Print position is incorrect

(d Confirm the margin settings in your application. Make sure that the margins are within the
printable area of the page.
= See “Printable area” on page 207.

(d Make sure the printer driver settings are appropriate for the paper size you are using.

For Windows, confirm the settings in the Main Window.
For Mac OS X, confirm the settings in the Page Setup dialog or Print dialog.
See the printer driver online help for details.

(d (For Windows)
Adjust the offset settings for manual 2-sided printing or 1-sided printing. To adjust the
settings, access the printer driver, click the Maintenance tab, click the Extended Settings
button, and move the Top and Left slider in the Offset to the appropriate position.

(d Uninstall the printer driver, then reinstall it.
= See “Uninstalling the Printer Software” on page 20.

Printout has a slight slant

Make sure that the paper is loaded into the front paper cassette or the rear sheet feeder correctly.
= See “Loading Paper” on page 25.

Inverted image

(d Clear the Mirror Image check box in the settings from your printer driver, or turn off the
Mirror Image setting in your application.

For Windows, confirm the settings in the Page Layout window.
For Mac OS X, confirm the settings in the Print Settings dialog in the Print dialog.

For instructions, see the online help for your printer driver or for your application.
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(d Uninstall the printer driver, then reinstall it.
= See “Uninstalling the Printer Software” on page 20.

Blank pages print
[d Make sure the printer driver settings are appropriate for the paper size you are using.

For Windows, confirm the settings in the Main window.
For Mac OS X, confirm the settings in the Page Setup dialog or Print dialog.
See the printer driver online help for details.

d Confirm the Skip Blank Page setting from your printer driver.

For Windows, click the Speed & Progress button on the Maintenance window.
For Mac OS X, confirm the Extension Settings in the Print dialog.
If it is selected, blank pages in your data are not printed.

(d Uninstall the printer driver, then reinstall it.
= See “Uninstalling the Printer Software” on page 20.

After trying one or more of these solutions, run a printer operation check to check your results.
= See “Running a printer operation check” on page 166.

Printed side is smeared or scuffed

[ Ifthe paperis curled toward the printable side, flatten it or curl it slightly in the opposite direction.
(d Clear the High Speed check box in the settings from your printer driver.

For Windows, confirm the settings in the Advanced window.
For Mac OS X, confirm the settings in the Print Settings dialog in the Print dialog.
See the printer driver online help for details.

(d Uninstall the printer driver, then reinstall it.
= See “Uninstalling the Printer Software” on page 20.
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Printing is too slow

a

a

Make sure the paper type selected in the printer driver is appropriate for the type of paper
loaded in the printer.
= See “Selecting the Correct Paper Type” on page 34.

For Windows, clear all customized settings and select Text as the Quality Option from your
printer driver’s Main window.

For Mac OS X, clear all customized settings and select Automatic as the Mode and move the
slider to Speed in the Print Settings dialog in the Print dialog of your printer driver. See the
printer driver online help for details.

= See “Accessing the printer driver for Windows” on page 16.
= See “Accessing the printer driver for Mac OS X” on page 17.

Close any unnecessary applications.

If you print continuously for an extended period, printing may become extremely slow. This is
to prevent the printer mechanism from overheating and being damaged. If this happens, you
can continue to print, but we recommend stopping and leaving the printer idle for at least
thirty minutes with the power on. (The printer does not recover with the power off.) After you
restart, the printer will print at normal speed.

This printer checks the print head on a regular basis to keep the print head clean and to ensure
you receive premium print quality. If the print head nozzles are clogged, the printer
automatically cleans the print head. During self-checking, and during self-cleaning operation,
the print speed may decrease.

Uninstall the printer driver, then reinstall it.
= See “Uninstalling the Printer Software” on page 20.

If you try all of the methods above and cannot solve the problem, see the following:
= See “Increasing the Print Speed (for Windows only)” on page 187.

Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:
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The paper is not curled or creased.
The paper is not too old. See the instructions that came with the paper for more information.
The paper fits under the = arrow mark inside the edge guide.

The number of sheets in the paper stack does not exceed the limit specified for the media.
= See “Loading capacities for Epson special media” on page 24.

Paper is not jammed inside the printer. If it is, remove the jammed paper.
= See “The Paper Jams” on page 172.

The & Ink status light is not on.

You have followed any special loading instructions that came with your paper. Load the paper
again.
= See “Loading Paper” on page 25.

Multiple pages feed

a
a

Make sure the paper stack fits under the = arrow mark inside the edge guide.
Make sure the left edge guide is snug against the left edge of the paper.

Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the
opposite side before loading.

Remove the stack of paper and make sure that the paper is not too thin.
= See “Paper” on page 206.

Fan the edges of the stack to separate the sheets, then reload the paper.

If too many copies of a file are being printed, confirm the Copies setting in your printer driver
as follows, and also confirm in your application.

For Windows, confirm the Copies setting on the Page Layout window.

For Mac OS X 10.3 and 10.4, confirm the Copies setting in the Copies & Pages setting in the
Print dialog.

For Mac OS X 10.5, confirm the Copies setting in the Print dialog.

See the printer driver online help for details.
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Paper is improperly loaded

If you have loaded the paper too far into the printer, the printer cannot feed the paper correctly.
Turn off the printer and gently remove the paper. Then turn on the printer and reload the paper
correctly.

Paper is not ejected fully or is wrinkled

A Clear the jammed paper as explained in “The Paper Jams” on page 172. Also, confirm the
Paper Size setting in your application or printer settings. See the online help for details.

[ Ifthe paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

Note:
Store any unused paper in its original packaging in a dry area.

The Printer Does Not Print

All lights are off

A Press the © Power button to make sure the printer is on.
(d Turn off the printer and make sure that the power cord is securely plugged in.

[ Make sure that your outlet works and is not controlled by a wall switch or timer.

Lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the printer and unplug it
immediately. Then check the label on the back of the printer.

Caution:

n If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact Epson
Service Center.
= See “Contacting Epson Support” on page 190.
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The Power light is on

a

If no buttons are pressed for 3 minutes, all lights other than the O Power light automatically
turn off to save energy. Press any button (except the O Power button) to return the control
panel to its previous state.

Turn off the printer and computer. Make sure the printer’s interface cable is securely plugged in.
If you are using the USB interface, make sure your cable meets the USB 1.1 or 2.0 standards.

If you are connecting the printer to your computer via a USB hub, connect the printer to the
first-tier hub from your computer. If the printer driver is still not recognized on your
computer, try to directly connect the printer to your computer without the USB hub.

If you are connecting the printer to your computer via a USB hub, make sure the USB hub
device is recognized by your computer.

Turn off the printer and the computer, disconnect the printer’s interface cable, then print an
operation check page.
= See “Running a printer operation check” on page 166.

If the check page prints correctly, make sure the printer driver and your application are
installed correctly.

If you are trying to print a large image, your computer may not have enough memory. Try
reducing the resolution of your image or printing the image at a smaller size. You may need to
install more memory in your computer.

Uninstall the printer driver, then reinstall it.
= See “Uninstalling the Printer Software” on page 20.
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Increasing the Print Speed (for Windows only)

Print speed may be increased by selecting certain settings in the Speed & Progress window when
the printing speed is slow. Click the Speed & Progress button on your printer driver’s

Maintenance window.

& EPSON 200000 Printing Preferences (b
| r Shotcut | & Main| 185 Advenced| () Page Layou [ 7 Marienancs)

&

&

=
o
]

EFSOMN Status Monitor 3

Lze this utility o automaticaly check for errors snd also check
the lervel of ink remaining,

Mozzle Chedk.
Use this utility if gaps or Faint 2reas appear in your prinkout,

Hudclenw

Lse this utility f w:u pr‘nt quality dm:i'm l:lrutl';l‘hezhﬂnck
indicates clogged nozzles

Print Head Alignment
Use this utility if misaligned wertical lings sppesr in your
prinbot,

Prirter and Cption Information

Use this utlity bo creahe or verfy settings For your printer and
optional devices.

===

ok [ coca || aoon

Troubleshooting

187



B-310N/B-510DN  User’s Guide

The following dialog box appears.

Speed & Progress

Settings

High Speed Copies

Show Progress Meter

[ ] Disable EFS0M Skatus Monitar 3
[ 5kip Blank Page

Monitoring Preferences

[ ] always spool Raw datatype

[ ]Page Rendeting Mode

|:| Prink as Bitmap

[ ] allow applications ko Perform ICM Colar Makching
[ ]change Standard Resolution

[Reset DeFauIts] | Ok i [ Zancel

J |

Help

The table below lists the factors affecting print speed.

Print speed Faster Slower
High Speed Copies On Off
Always spool RAW datatype On Off
Page Rendering Mode On Off
Print as Bitmap On Off

For more details on each item, see the online help.

Troubleshooting

188



B-310N/B-510DN  User’s Guide

Other Problems

Print head cleaning does not start

[ Make sure that no lights are indicating errors. If any error occurs, recover from the error
status.

= See “Error indicators” on page 166.

(d Make sure that sufficient ink remains for printing. If the ink cartridge is expended, replace the
cartridge.

= See “Replacing an ink cartridge” on page 142.

The color ink is consumed even when printing in black ink only

Not only the black ink but also the color ink are consumed during the following operations: print
head cleaning, print head self-check, and self-cleaning.

Printing plain paper quietly

When plain papers is selected as the Paper Type setting and Normal or Fine is selected as the
Print Quality setting in the printer driver, the printer prints at high speed. Try choosing Quiet
Mode for quieter operation which will reduce the print speed.

For Windows, select the Quiet Mode check box in the Main or Advanced window of your printer
driver.

For Mac OS X, select Print Settings in the Print dialog box of your printer driver. Then select the
Quiet Mode check box in Advanced mode.

Feel a slight electric shock when you touch the printer (short-circuit)

If you use the outlet on the same circuit as other peripheral devices, you may feel a slight electric
shock when you touch the printer. In this case, it is recommended to ground from the computer
that the printer connects to.
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Appendix A
Where To Get Help

Technical Support Web Site
Epson’s Technical Support Web Site provides help with problems that cannot be solved using the
troubleshooting information in your product documentation. If you have a Web browser and can
connect to the Internet, access the site at:
http://support.epson.net/
If you need the latest drivers, FAQs, manuals, or other downloadables, access the site at:

http://www.epson.com

Then, select the support section of your local Epson Web site.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the
troubleshooting information in your product documentation, contact Epson support services for
assistance. If Epson support for your area is not listed below, contact the dealer where you
purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

(d Product serial number
(The serial number label is usually on the back of the product.)

(d Product model

(1 Product software version
(Click About, Version Info, or similar button in the product software.)

(J Brand and model of your computer
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d Your computer operating system name and version

[ Names and versions of the software applications you normally use with your product

Help for Users in North America

Epson provides the technical support services listed below.

Internet Support

Visit Epson’s support website at http://epson.com/support and select your product for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative

Dial: (562) 276-1300 (U.S.), or (905) 709-9475 (Canada), 6 am to 6 pm, Pacific Time, Monday
through Friday. Days and hours of support are subject to change without notice. Toll or long
distance charges may apply.

Before you call Epson for support, please have the following information ready:

Product name
Product serial number
Proof of purchase (such as a store receipt) and date of purchase

Computer configuration

O 0 UJ d o

Description of the problem

Note:
For help using any other software on your system, see the documentation for that software for
technical support information.

Purchase Supplies and Accessories

You can purchase genuine Epson ink cartridges, ribbon cartridges, paper, and accessories from an
Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or
you can purchase online at http://www.epsonstore.com (U.S. sales) or http://www.epson.ca
(Canadian sales).
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Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your
product documentation, we provide the following sources for obtaining information:

Your Dealer

Don’t forget that your dealer can often help identify and resolve problems. The dealer should
always be the first call for advise on problems; they can often solve problems quickly and easily as
well as give advise on the next step to take.

Internet URL http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the
occasional surf! The site provides a download area for drivers, Epson contact points, new product
information and technical support (e-mail).

Epson Helpdesk

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice.
Operators on the Helpdesk can aid you in installing, configuring and operating your Epson
product. Our Pre-sales Helpdesk staff can provide literature on new Epson products and advise
where the nearest dealer or service agent is located. Many types of queries are answered here.

The Helpdesk numbers are:

Phone: 1300 361 054

Fax: (02) 8899 3789
We encourage you to have all the relevant information on hand when you ring. The more
information you prepare, the faster we can help solve the problem. This information includes your

Epson product documentation, type of computer, operating system, application programs, and
any information you feel is required.
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Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:

World Wide Web (http://www.epson.com.sg)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ),
Sales Enquiries, and Technical Support via e-mail are available.

Epson HelpDesk (Phone: (65) 6586 3111)

Our HelpDesk team can help you with the following over the phone:

(d Sales enquiries and product information
(d Product usage questions or problems

(d Enquiries on repair service and warranty

Help for Users in Thailand

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.th)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ),
and e-mail are available.

Epson Hotline (Phone: (66)2685-9899)
Our Hotline team can help you with the following over the phone:

(4 Sales enquiries and product information
(d Product usage questions or problems

(d Enquiries on repair service and warranty

Help for Users in Vietnam

Contacts for information, support, and services are:
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Epson Hotline 84-8-823-9239

(Phone):

Service Center: 80 Truong Dinh Street, District 1, Hochiminh City
Vietnam

Help for Users in Indonesia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.id)

(d Information on product specifications, drivers for download

(d Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Hotline

(d Sales enquiries and product information

(d Technical support

Phone (62) 21-572 4350
Fax (62) 21-572 4357
Epson Service Center
Jakarta Mangga Dua Mall 3rd floor No 3A/B
JI. Arteri Mangga Dua,
Jakarta

Phone/Fax: (62) 21-62301104

Bandung Lippo Center 8th floor
J1. Gatot Subroto No.2
Bandung

Phone/Fax: (62) 22-7303766
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Surabaya Hitech Mall It IIB No. 12
JI. Kusuma Bangsa 116 — 118
Surabaya

Phone: (62) 31-5355035
Fax: (62)31-5477837

Yogyakarta Hotel Natour Garuda
J1. Malioboro No. 60
Yogyakarta

Phone: (62) 274-565478

Medan Wisma HSBC 4th floor
JI. Diponegoro No. 11
Medan

Phone/Fax: (62) 61-4516173

Makassar MTC Karebosi Lt. Ill Kav. P7-8
JI. Ahmad Yani No.49
Makassar

Phone: (62)411-350147/411-350148

Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact
Epson Hong Kong Limited.

Internet Home Page

Epson Hong Kong has established a local home page in both Chinese and English on the Internet
to provide users with the following information:

[ Product information
(d Answers to Frequently Asked Questions (FAQs)
[ Latest versions of Epson product drivers

Users can access our World Wide Web home page at:
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http://www.epson.com.hk
Technical Support Hotline
You can also contact our technical staft at the following telephone and fax numbers:

Phone: (852) 2827-8911

Fax: (852) 2827-4383

Help for Users in Malaysia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.com.my)

(d Information on product specifications, drivers for download

(d Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Trading (M) Sdn. Bhd.

Head Office.

Phone: 603-56288288

Fax: 603-56288388/399
Epson Helpdesk

(d Sales enquiries and product information (Infoline)

Phone: 603-56288222

(d Enquiries on repair services & warranty, product usage and technical support (Techline)

Phone: 603-56288333
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Help for Users in India

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.in)

Information on product specifications, drivers for download, and products enquiry are available.

Epson India Head Office - Bangalore
Phone: 080-30515000

Fax: 30515005

Epson India Regional Offices:

Location Telephone number Fax number
Mumbai 022-28261515/16/17 022-28257287
Delhi 011-30615000 011-30615005
Chennai 044-30277500 044-30277575
Kolkata 033-22831589/90 033-22831591
Hyderabad 040-66331738/ 39 040-66328633
Cochin 0484-2357950 0484-2357950
Coimbatore 0422-2380002 NA

Pune 020-30286000 /30286001/30286002 020-30286000
Ahmedabad 079-26407176 /77 079-26407347

Helpline

For Service, Product info or to order a cartridge - 18004250011 (9AM - 9PM) - This is a Toll-free

number.

For Service (CDMA & Mobile Users) - 3900 1600 (9AM - 6PM) Prefix local STD code
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Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the
Epson Philippines Corporation at the telephone and fax numbers and e-mail address below:

Trunk Line: (63-2) 706 2609

Fax: (63-2) 706 2665

Helpdesk Direct (63-2) 706 2625

Line:

E-mail: epchelpdesk@epc.epson.com.ph

World Wide Web (http://www.epson.com.ph)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ),
and E-mail Enquiries are available.

Toll-Free No. 1800-1069-EPSON(37766)
Our Hotline team can help you with the following over the phone:

(d Sales enquiries and product information
(d Product usage questions or problems

(d Enquiries on repair service and warranty
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Appendix B
Product Information

Printer Parts

Front view

a.  Edge guide: Holds your paper straight in the rear sheet feeder. Move it to the edge of your
paper.

b.  Rear sheet feeder: Holds your paper and feeds it for printing.
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Paper support: Supports the paper loaded in the rear sheet feeder.
Front printer cover: Covers the printing mechanism. Open only when the paper jams.
Print Head: Prints ink on your paper.

Control panel: Use the buttons and monitor the LCD screen and lights to control your
printer.
= See “Using the Control Panel” on page 121.

Maintenance box cover: Covers the maintenance box. Open only when replacing the
maintenance box.

Output tray: Holds the ejected paper.
Front paper cassette (Front Tray): Holds your paper and feeds it for printing.
Cartridge lever: Locks the installed ink cartridges.

Cartridge cover: Covers the ink cartridges. Open when replacing the ink cartridges. When
using the extra high capacity ink cartridge, leave opened.
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Rear view

B-310N
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a.  USB connector: Connects the USB cable from your computer to the printer.

b.  Ethernet connector: Connects the 10Base-T/100Base-TX cable from your computer to the
printer.

c.  Upper rear printer cover: Covers the printing mechanism. Open when attaching the
duplex unit and when the paper jams in the back of the printer.

d.  Duplex unit (Duplexer): Prints 2-sided printing automatically.
e.  ACinlet: Connects the power cord.
f. Rear printer cover: Covers the printing mechanism. Open only when the paper jams.

g.  Vent hole: Ejects the heated air from the printer.
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Paper, Consumables, and Options

Paper

Epson offers specially-designed paper and other print media for all your printing needs.

Note:

You can find the part numbers for the following Epson special papers on the Epson support Web site.

= See “Technical Support Web Site” on page 190.

Paper Size
Epson Bright White Ink Jet Paper A4
Epson Matte Paper-Heavyweight A4
Epson Double-Sided Matte Paper A4
Epson Photo Quality Ink Jet Paper A4
Epson Photo Quality Self Adhesive Sheet A4
Epson Professional Flyer Paper A4
Epson Photo Paper A4

Note:

The availability of paper varies by location.

Ink cartridges

You can use the following ink cartridges with this printer:

Ink cartridge

Part numbers

B-510DN B-310N
Standard capacity High capacity Extra High
capacity
Black T6161 T6171 T6181 T6161
Cyan T6162 T6172 - T6162
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Ink cartridge

Part numbers

B-510DN B-310N
Standard capacity High capacity Extra High
capacity
Magenta T6163 T6173 - T6163
Yellow T6164 T6174 - T6164
Note:

Ink cartridge part numbers vary by location.

Maintenance box

You can use the following maintenance box with this printer:

Part number

Maintenance Box

T6190

Duplex unit (B-310N users only)

You can use the following duplex unit with B-310N.

Part number

Duplex unit

C802531

Legal-size paper support

You can use the following legal-size paper support.

Part number

Legal-size paper support C815341

Product Information

204



B-310N/B-510DN  User’s Guide

Legal-size paper cassette

You can use the following legal-size paper cassette.

Part number

Legal-size paper cassette C817001

System Requirements

For using the printer

Windows requirements

To use this printer, you must have any of the following Windows operating systems installed. For
details on interfaces and operating systems, refer to the following table.

System

PC Interface

Windows 7, Vista, XP, 2000, Server 2008, and Server 2003.
USB 2.0 Host Driver by Microsoft must be used.

USB 2.0

Ethernet 100Base-TX/10Base-T (Compatible with
1000Base-T)

Macintosh requirements

To connect this printer to a Macintosh computer, you must have any of the following Macintosh
operating systems installed. For details on interfaces and operating systems, refer to the following

table.

System

PC Interface

PowerPC-based or Intel-based Macintosh computers
running Mac OS X 10.3.9 or later

USB 2.0

Ethernet 100Base-TX/10Base-T (Compatible with
1000Base-T)
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Technical Specifications

Paper

Note:

[ Since the quality of any particular brand or type of paper may be changed by the manufacturer
at any time, Epson cannot attest to the quality of any non-Epson brand or type of paper. Always
test samples of paper stock before purchasing large quantities or printing large jobs.

[ Poor quality paper may reduce print quality and cause paper jams or other problems. If you
encounter problems, switch to a higher grade of paper.

[ Use paper under normal conditions:
Temperature 15 to 25 °C (59 to 77 °F)
Humidity 40 to 60% RH

1 Ifallthe conditions below are met, pre-punched paper with binding holes can be used for this printer:

Paper source

rear sheet feeder

Paper size

A4, A5, A6, B5, Letter, Legal

Hole position

Within 19 mm (0.74 in) from the left side of paper facing the printing
surface. See the illustration below.

I 000000000000 O0OOOOOOO0OOOOOO0

19mm

Single sheets:
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Size 1-sided manual automatic
printing 2-sided 2-sided
printing printing

A4210x 297 mm v v v
10x15cm (4 x6in.) v v -
A6 105 x 148 mm v v -
A5 148 %210 mm v v -
B5 182 %257 mm v v v
13x20cm (5% 8in.) v v -
20x25cm (8 10in.) v v -
16:9 wide size (102 x 181 mm) v v -
100 x 148 mm v v -
Letter81/2x 11in. v v v
Legal 8 1/2 x 14 in. 7" Vel Ve

Paper types Plain bond paper or special paper distributed by Epson

Weight Plain bond paper: 64 g/m” to 90 g/m?
Thick plain bond paper: 91 g/m? to 256 g/m?

* When you print from the front tray, use the optional Legal-size paper cassette

Envelopes:
Size Envelope #104 1/8 X9 1/2in.
Envelope DL 110 X 220 mm
Envelope C6 114 X 162 mm
Paper types Plain bond paper
Weight 75 g/m’” to 90 g/m?
Printable area

Diagonal lines show printable area.
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Single sheets:
W
B-L—
Envelopes:
Minimum margin
Media type Single sheets Envelopes
A 3.0mm (0.12in.) ™ 3.0mm (0.12in.)
B-L, B-R 3.0mm (0.12in.) 5.0 mm (0.20 in.)
C 3.0mm (0.12in.) ™ 3.0mm (0.12in.)

“116mm (0.630 in.) when printing folded booklet using the duplex unit
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Note:
d Depending on the type of paper, print quality may decline in the top and bottom areas of the
printout, or the area may be smeared.

O Automatic 2-sided printing supports plain paper only. Thick plain paper is not supported.
Minimum margin for C is 16 mm (0.63 in.) when you use automatic 2-sided printing.

Ink cartridges
Color Yellow, Magenta, Cyan, Black
Cartridge life Use within 6 months of opening the package.
Temperature Storage:

-20t040°C(-4to 104 °F)
1 month at 40 °C (104 °F)

Freezing:"
13°C(8.6°F)

*Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F)

n Caution:
(A Epson recommends the use of genuine Epson ink cartridges. Other products not
manufactured by Epson may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic printer behavior.

(A Use the ink cartridge before the date printed on its package.

Note:

[  The ink cartridges packaged with your printer are partly used during initial setup. In order to
produce high quality printouts, the print head in your printer will be fully charged with ink. This
one-off process consumes a quantity of ink and therefore these cartridges may print fewer pages
compared to subsequent ink cartridges.

[ Yields vary considerably based on images printed, print settings, paper type, frequency of use and
temperature.

[ To ensure you receive premium print quality and to help protect your print head, a variable ink
safety reserve remains in the cartridge when your printer indicates to replace the cartridge. The
yields quoted for you do not include this reserve.

d  Although the ink cartridge may contain recycled materials, this does not affect product function
or performance.
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Mechanical

Paper path

Front paper cassette, rear sheet feeder

Loading capacity

Front paper cassette
About 500 sheets at 75 g/m? paper

Rear sheet feeder
About 100 sheets at 75 g/m? paper

Dimensions

B-510DN

Storage

Width: 480 mm (18.9in.)
Depth: 489 mm (19.3in.)
Height: 312 mm (12.3in.)
Printing

Width: 480 mm (18.9in.)
Depth: 656 mm (25.8 in.)
Height: 372 mm (14.6 in.)

B-310N
Storage
Width: 480 mm (18.9in.)
Depth: 420 mm (16.5in.)
Height: 312 mm (12.3in.)
Printing
Width: 480 mm (18.9in.)
Depth: 625 mm (24.6in.)
Height: 372 mm (14.6 in.)

Weight

B-510DN

Approx. 10.7 kg (23.6 Ib) (without the ink cartridges and power cord)

B-310N

Approx. 10.0 kg (22.0 Ib) (without the ink cartridges and power cord)

* Loading capacity may decrease if the paper is curled.
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Electrical

100-120 V Model

220-240 V Model

Input voltage range

AC90to 132V

AC198t0 264V

Rated frequency range

50 to 60 Hz

Input frequency range

49.510 60.5 Hz

Rated current

Power consumption

0.7 A 04A
Printing Approx. 30.0 W Approx. 30.0 W
(ISO/IEC24712 (ISO/IEC24712
Pattern) Pattern)
Ready mode Approx. 6.5 W Approx. 7.0 W
Sleep mode Approx.3.5W Approx.3.5W
Power off Approx. 0.2 W Approx. 0.4 W

Note:

Check the label on the back of the printer for its voltage.

Environmental

Temperature

Operation: !

10to 35 °C (50 to 95 °F)

Storage:

-20t040°C(-4to 104 °F)

1 month at 40 °C (104 °F)

Humidity

Operation: "2
20to 80% RH

Storage:” 5 to 85% RH

*1 Printing may slow down depending on the environment

*2 Without condensation

Standards and approvals

U.S. model:
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Safety UL60950-1
CAN/CSA-C22.2 No.60950-1

EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

European model:

Low voltage directive 2006/95/ EN60950-1

EC
EMC directive 2004/108/EC EN55022 Class B
EN61000-3-2
EN61000-3-3
EN55024
Australian model:
EMC AS/NZS CISPR22 Class B

Interface

USB 2.0 Hi-Speed (Device Class for computers)

Ethernet TO0BASE-TX/10 BASE-T

Option

Duplex unit (B-310N only) Width: 313 mm (12.3in.)
Depth: 163 mm (6.4 in.)
Height: 92 mm (3.6 in.)

Weight: Approx. 0.9 kg (1.98 Ib)

Legal-size paper support Width: 1776 mm (6.9 in.)
Depth: 7.4 mm (0.3 in.)
Height: 110 mm (4.3 in.)
Weight: Approx. 42 g (0.09 |b)
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Legal-size paper cassette Width: 250 mm (9.8 in.)
Depth: 430 mm (16.9in.)
Height: 71 mm (2.8 in.)
Weight: Approx. 0.7 kg (1.5 Ib)
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